Legal Notices

Novell, Inc. makes no representations or warranties with respect to the contents or use of this documentation, and specifically disclaims any express or implied warranties of merchantability or fitness for any particular purpose. Further, Novell, Inc. reserves the right to revise this publication and to make changes to its content, at any time, without obligation to notify any person or entity of such revisions or changes.

Further, Novell, Inc. makes no representations or warranties with respect to any software, and specifically disclaims any express or implied warranties of merchantability or fitness for any particular purpose. Further, Novell, Inc. reserves the right to make changes to any and all parts of Novell software, at any time, without any obligation to notify any person or entity of such changes.

You may not use, export, or re-export this product in violation of any applicable laws or regulations including, without limitation, U.S. export regulations or the laws of the country in which you reside.

Copyright © 2002-2005 Novell, Inc. All rights reserved. No part of this publication may be reproduced, photocopied, stored on a retrieval system, or transmitted without the express written consent of the publisher.

Novell, Inc. has intellectual property rights relating to technology embodied in the product that is described in this document. In particular, and without limitation, these intellectual property rights may include one or more of the U.S. patents listed at http://www.novell.com/company/legal/patents/ and one or more additional patents or pending patent applications in the U.S. and in other countries.

Novell, Inc.
404 Wyman Street, Suite 500
Waltham, MA 02451
U.S.A.

www.novell.com

Novell Server Consolidation Utility 4.0 Administration Guide
June 1, 2005

Online Documentation: To access the online documentation for this and other Novell products, and to get updates, see www.novell.com/documentation.
**Novell Trademarks**

ConsoleOne is a registered trademark of Novell, Inc. in the United States and other countries.

eDirectory is a trademark of Novell, Inc.

Internetwork Packet Exchange and IPX are trademarks of Novell, Inc.

NetWare is a registered trademark of Novell, Inc. in the United States and other countries.

NetWare Core Protocol and NCP are trademarks of Novell, Inc.

NetWare Loadable Module and NLM are trademarks of Novell, Inc.

Novell is a registered trademark of Novell, Inc. in the United States and other countries.

Novell Client is a trademark of Novell, Inc.

Novell Cluster Services is a trademark of Novell, Inc.

Novell Directory Services and NDS are registered trademarks of Novell, Inc. in the United States and other countries.

Novell Distributed Print Services is a trademark and NDPS is a registered trademark of Novell, Inc. in the United States and other countries.

Novell Storage Services is a trademark of Novell, Inc.

Nterprise is a trademark of Novell, Inc.

Nterprise Branch Office is a trademark of Novell, Inc.

Storage Management Services and SMS are trademarks of Novell, Inc.

SUSE is a registered trademark of Novell, Inc.

ZENworks is a registered trademark of Novell, Inc.

**Third-Party Materials**

All third-party trademarks are the property of their respective owners.
Contents

About This Guide 7

1 Server Consolidation Overview 9
   About the Novell Server Consolidation Utility .................................................. 9
   Types of Server Consolidation Projects ............................................................... 9
   Drag-and-Drop Modeling ....................................................................................... 10
   Server Consolidation Scenarios ............................................................................ 11
   Basic Server Consolidation: Many-to-One ............................................................. 11
   Consolidaing Data from Multiple Servers onto a Two-Node Cluster ................... 11
   Cross-Platform Data Consolidations ..................................................................... 12
   What’s Next. .......................................................................................................... 12

2 What’s New 13
   Product History .................................................................................................... 13
   Server Consolidation Utility 4.0 .......................................................................... 13
   Server Consolidation Utility 3.0 .......................................................................... 13
   Server Consolidation Utility 2.6 .......................................................................... 13
   Server Consolidation Utility 2.0 .......................................................................... 14
   Server Consolidation Utility 1.0 .......................................................................... 14
   What’s Next. ........................................................................................................ 14

3 Preparing for a Server Consolidation 15
   Meet System and Software Requirements ............................................................ 15
      Workstation Requirements ................................................................................ 15
   Install the Server Consolidation Utility ............................................................... 16
   Prepare the Source and Destination Servers ....................................................... 16
      Preparing NetWare 4 Source Servers ................................................................ 17
      Modifying the Hosts File .................................................................................. 18
   Tips for Successful Consolidations ..................................................................... 19
   Scheduling a Consolidation Project to Run at a Later Time ............................... 19
   What’s Next. ........................................................................................................ 21

4 Consolidating Data from NetWare Servers 23
   Understand NetWare Server Consolidation Issues ............................................ 23
      Open Files Cannot Be Copied ........................................................................... 23
      Cluster Failover Stops File Copy ....................................................................... 24
      Consolidating NDPS Printer Agents .................................................................. 24
   Create a Project File ............................................................................................. 24
   Select a Source and Destination Tree ................................................................. 25
   Model Your Consolidation Project ...................................................................... 25
   Perform Pre-Copy Verifications .......................................................................... 27
   Resolve Errors ..................................................................................................... 32
      Match Up Tree Objects ..................................................................................... 32
      Default Server and Home Directory for Created Users .................................. 35
   Run the Consolidation ......................................................................................... 35
   Consolidating Data to or from a NetWare 5.1 Cluster ......................................... 35
### Novell Server Consolidation Utility 4.0 Administration Guide

#### 5 Consolidating Data from Windows Servers
- **Understand Windows Consolidation Issues** .................................................. 41
- **Meet System and Software Requirements** ........................................... 42
- **Perform Prerequisite Tasks** ................................................................. 42
  - **Create a Template Object** ............................................................... 42
  - **Register the Workstation** ................................................................. 43
- **Create a Project File** ................................................................. 43
- **Model Your Consolidation Project** .................................................. 45
- **Verify Your Consolidation Project** .................................................. 45
- **Run the Consolidation** ................................................................. 46
- **Perform Post-Consolidation Tasks** .................................................. 48
  - **Novell ZENworks and Roaming Profiles** ......................................... 48

#### 6 Consolidating Data to OES Linux
- **Meet System and Software Requirements** ........................................... 49
- **Understand NetWare-to-Linux Data Migration Issues** .......................... 50
  - **Use of SMS to Copy Data** .............................................................. 50
  - **File/Directory Rights and Attributes Supported on Linux** .................. 50
  - **New attrib Command for OES Linux** ............................................ 51
  - **Creation Dates Change from NetWare to Linux** .................................. 51
  - **NFS Name Space Required when Copying Data from TFS on NetWare to NSS on Linux** .................................................. 51
  - **Disable Server Consolidation Utility File and Folder Comparison** .......... 51
  - **Enable UTF-8 Encoding on NCP Client for SCU** ................................... 51
- **Understand Windows-to-Linux Migration Issues** .................................. 51
- **Understand the Need for Linux Enabling Users** ................................... 52
  - **Maintaining File Ownership Information** ......................................... 52
- **Additional Linux Screens in the Server Consolidation Utility** .................. 52
- **Run the nambulkadd Command** ........................................................ 54

#### 7 Troubleshooting
- **Troubleshooting the Server Consolidation Utility** ............................... 57

#### 8 Changing the NetWare Server Code Page
- **Install a NetWare Server with Regional Support** ..................................... 63
- **Convert an Existing NetWare Server to a Foreign Code Page** .................. 64
- **Verifying the Current Code Page on a NetWare Server** .......................... 65

---

Consolidating Data to Nterprise Branch Office ........................................... 36
Unlocking the Nterprise Branch Office Appliance ....................................... 36
Performing a Server Consolidation to a Novell Nterprise Branch Office Appliance ........................................... 37
Consolidating Data from NetWare 4 Servers ........................................... 38
  - **Binding IPX on the Server** .............................................................. 38
  - **Binding IPX on the Client** .............................................................. 39
  - **Verifying IPX Is Bound on the Client** ............................................. 39

Verifying the Current Code Page on a NetWare Server ................................ 65
Convert an Existing NetWare Server to a Foreign Code Page .......................... 64
Run the nambulkadd Command .............................................................. 54

---

Verifying IPX Is Bound on the Client .......................................................... 39
Binding IPX on the Server ................................................................. 38
Binding IPX on the Client .............................................................. 39
Verifying IPX Is Bound on the Client .................................................. 39

---

Understanding the Need for Linux Enabling Users ....................................... 52
Understanding Windows Consolidation Issues ........................................... 41
Meet System and Software Requirements ........................................... 42
Perform Prerequisite Tasks ................................................................. 42
Create a Template Object ................................................................. 42
Register the Workstation ................................................................. 43
Create a Project File ................................................................. 43
Model Your Consolidation Project .................................................. 45
Verify Your Consolidation Project .................................................. 45
Run the Consolidation ................................................................. 46
Perform Post-Consolidation Tasks .................................................. 48
Novell ZENworks and Roaming Profiles .................................................. 48

---

Understand Windows-to-Linux Migration Issues ........................................... 51
Understand the Need for Linux Enabling Users ........................................... 52
Maintaining File Ownership Information ........................................... 52
Additional Linux Screens in the Server Consolidation Utility .......................... 52
Run the nambulkadd Command .............................................................. 54

---

Unlocking the Nterprise Branch Office Appliance ....................................... 36
Performing a Server Consolidation to a Novell Nterprise Branch Office Appliance ........................................... 37
Consolidating Data from NetWare 4 Servers ........................................... 38

---

Creation Dates Change from NetWare to Linux ........................................... 51
NFS Name Space Required when Copying Data from TFS on NetWare to NSS on Linux .................................................. 51

---

Meet System and Software Requirements ........................................... 42
Understand NetWare-to-Linux Data Migration Issues .................................. 50
Use of SMS to Copy Data ................................................................. 50
File/Directory Rights and Attributes Supported on Linux .......................... 50
New attrib Command for OES Linux .................................................. 51

---

New attrib Command for OES Linux .................................................. 51
Creation Dates Change from NetWare to Linux ........................................... 51
NFS Name Space Required when Copying Data from TFS on NetWare to NSS on Linux .................................................. 51

---

Register the Workstation ................................................................. 43
Create a Template Object ................................................................. 42
Create a Project File ................................................................. 43
Model Your Consolidation Project .................................................. 45
Verify Your Consolidation Project .................................................. 45
Run the Consolidation ................................................................. 46
Perform Post-Consolidation Tasks .................................................. 48

---

Unlocking the Nterprise Branch Office Appliance ....................................... 36
Performing a Server Consolidation to a Novell Nterprise Branch Office Appliance ........................................... 37
Consolidating Data from NetWare 4 Servers ........................................... 38

---

Conversion Dates Change from NetWare to Linux ........................................... 51
NFS Name Space Required when Copying Data from TFS on NetWare to NSS on Linux .................................................. 51

---

Meet System and Software Requirements ........................................... 42
Understand NetWare-to-Linux Data Migration Issues .................................. 50
Use of SMS to Copy Data ................................................................. 50
File/Directory Rights and Attributes Supported on Linux .......................... 50
New attrib Command for OES Linux .................................................. 51
Creation Dates Change from NetWare to Linux ........................................... 51
NFS Name Space Required when Copying Data from TFS on NetWare to NSS on Linux .................................................. 51
Disable Server Consolidation Utility File and Folder Comparison .......................... 51
Enable UTF-8 Encoding on NCP Client for SCU ........................................... 51
Understand Windows-to-Linux Migration Issues ........................................... 51
Understand the Need for Linux Enabling Users ........................................... 52
Maintaining File Ownership Information ........................................... 52
Additional Linux Screens in the Server Consolidation Utility .......................... 52
Run the nambulkadd Command .............................................................. 54

---

Meeting System and Software Requirements ........................................... 42
Perform Post-Consolidation Tasks .................................................. 48
Novell ZENworks and Roaming Profiles .................................................. 48

---

Creation Dates Change from NetWare to Linux ........................................... 51
NFS Name Space Required when Copying Data from TFS on NetWare to NSS on Linux .................................................. 51

---

Meet System and Software Requirements ........................................... 42
Understand NetWare-to-Linux Data Migration Issues .................................. 50
Use of SMS to Copy Data ................................................................. 50
File/Directory Rights and Attributes Supported on Linux .......................... 50
New attrib Command for OES Linux .................................................. 51
Creation Dates Change from NetWare to Linux ........................................... 51
NFS Name Space Required when Copying Data from TFS on NetWare to NSS on Linux .................................................. 51
Disable Server Consolidation Utility File and Folder Comparison .......................... 51
Enable UTF-8 Encoding on NCP Client for SCU ........................................... 51
Understand Windows-to-Linux Migration Issues ........................................... 51
Understand the Need for Linux Enabling Users ........................................... 52
Maintaining File Ownership Information ........................................... 52
Additional Linux Screens in the Server Consolidation Utility .......................... 52
Run the nambulkadd Command .............................................................. 54

---

Creation Dates Change from NetWare to Linux ........................................... 51
NFS Name Space Required when Copying Data from TFS on NetWare to NSS on Linux .................................................. 51

---

Meet System and Software Requirements ........................................... 42
Understand NetWare-to-Linux Data Migration Issues .................................. 50
Use of SMS to Copy Data ................................................................. 50
File/Directory Rights and Attributes Supported on Linux .......................... 50
New attrib Command for OES Linux .................................................. 51
Creation Dates Change from NetWare to Linux ........................................... 51
NFS Name Space Required when Copying Data from TFS on NetWare to NSS on Linux .................................................. 51
Disable Server Consolidation Utility File and Folder Comparison .......................... 51
Enable UTF-8 Encoding on NCP Client for SCU ........................................... 51
Understand Windows-to-Linux Migration Issues ........................................... 51
Understand the Need for Linux Enabling Users ........................................... 52
Maintaining File Ownership Information ........................................... 52
Additional Linux Screens in the Server Consolidation Utility .......................... 52
Run the nambulkadd Command .............................................................. 54

---

Meeting System and Software Requirements ........................................... 42
Perform Post-Consolidation Tasks .................................................. 48
Novell ZENworks and Roaming Profiles .................................................. 48

---

Meeting System and Software Requirements ........................................... 42
Perform Post-Consolidation Tasks .................................................. 48
Novell ZENworks and Roaming Profiles .................................................. 48

---

Meeting System and Software Requirements ........................................... 42
Perform Post-Consolidation Tasks .................................................. 48
Novell ZENworks and Roaming Profiles .................................................. 48
About This Guide

This guide describes how to use the Novell® Server Consolidation Utility to copy data from one location to another location on your Novell network. The guide is intended for network administrators and is divided into the following sections:

- Chapter 1, “Server Consolidation Overview,” on page 9 explains the capabilities of the Server Consolidation Utility.
- Chapter 3, “Preparing for a Server Consolidation,” on page 15 explains how to prepare your servers and provides instructions for installing the Server Consolidation Utility.
- Chapter 4, “Consolidating Data from NetWare® Servers,” on page 23 provides instructions for consolidating data and moving printers from NetWare® to NetWare using the Server Consolidation Utility.
- Chapter 5, “Consolidating Data from Windows® Servers,” on page 41 provides instructions for consolidating data from Windows® NT® or Active Directory® (AD) to NetWare using the Server Consolidation Utility.
- Chapter 6, “Consolidating Data to OES Linux,” on page 49 outlines special considerations and extra steps that are necessary when copying data to Novell Storage Services™ (NSS) volumes on an Open Enterprise Server (OES) Linux® destination server.
- “Troubleshooting” on page 57 provides solutions for resolving errors encountered during the consolidation process.
- Appendix A, “Changing the NetWare® Server Code Page,” on page 63 provides instructions for changing the code page on your source and destination NetWare servers, if necessary.

Documentation Updates

For the most recent version of the Novell Server Consolidation Utility Administration Guide, see the Novell Product Documentation Web site (http://www.novell.com/documentation).

Documentation Conventions

In this documentation, a greater-than symbol (>) is used to separate actions within a step and items in a cross-reference path.

Also, a trademark symbol (®, ™, etc.) denotes a Novell trademark. An asterisk (*) denotes a third-party trademark.

When a single pathname can be written with a backslash for some platforms or a forward slash for other platforms, the pathname is presented with a backslash. Users of platforms that require a forward slash, such as UNIX®, should use forward slashes as required by your software.
Additional Documentation

A video demo is available to walk users through the basics of running the Server Consolidation Utility. This video is best viewed at a screen resolution of 1024 x 768 or higher. If your screen resolution is set at 1024 x 728, view the video in full screen mode for best results.

You can either view the demo online (requires Macromedia® Flash® Player) or download the video file and play it on your workstation.


Novell Education offers a variety of courses that help you maximize your investment in NetWare. For course descriptions, details, and locations of training events, visit the Novell Education Web site (http://www.novell.com/education/netware6).
Novell® Server Consolidation Utility is a file-and-print consolidation tool that helps you reorganize your network by copying data from any number of existing source servers to any number of destination servers. The source server can even be the same as the destination server. By consolidating data onto newer, more powerful servers, you can simplify your network administration processes and lower your IT costs.

The Server Consolidation Utility also automates key tasks, such as migrating users and their file permissions, assigning passwords, and migrating the NetWare® or Microsoft® Windows® NT® file system or Windows 2000/2003 Active Directory® domains to a designated eDirectory™ tree. This automation eliminates the need to choose from various utilities that would help you perform these tasks individually.

**IMPORTANT:** If you want to migrate data from old hardware that is being replaced, use the Migration Wizard Utility that is available at Novell’s product download site (http://download.novell.com). Type Migration Wizard in the Keyword search field, click Search, then select the latest version of the NetWare Migration Wizard from the results list.

This chapter describes how the Server Consolidation Utility works and provides some example scenarios of how you can use it to consolidate your data.

For a list of new features and enhancements to Server Consolidation Utility, see Chapter 2, “What’s New,” on page 13.

### About the Novell Server Consolidation Utility

The Novell Server Consolidation Utility runs on a Windows workstation on the network.

See “Workstation Requirements” on page 15 for more information.

### Types of Server Consolidation Projects

When the utility starts up, you select either NetWare NDS®/eDirectory or Microsoft Windows Domain as the source type. This selection determines the type of your consolidation project.

#### NetWare/eDirectory Consolidations

For NetWare/eDirectory consolidations, the Server Consolidation Utility lets you copy entire volumes or specific directories to one or more destination servers in the same eDirectory tree or in different eDirectory trees. The accompanying rights, trustees, ownership, and name space information are copied to the destination server along with the files.

The following table lists the supported source and destination servers for NetWare/eDirectory consolidations.
NDPS Printer Agent Consolidations

As part of a NetWare/eDirectory consolidation, you can reassign several NDPS® Printer Agents within the same tree to a single NDPS Print Manager. This simplifies your network printing configuration.

Windows NT Domain Consolidations

You can also use the Server Consolidation Utility to copy data from Windows NT domains to servers in Novell eDirectory trees. As with NetWare data, permissions and ownership information for NTFS files and folders are transferred intact, along with the necessary users, groups, and passwords.

The following table lists the supported sources and destinations for Windows domain consolidations.

<table>
<thead>
<tr>
<th>Supported Sources</th>
<th>Supported Destinations</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows NT 4.0 with Support Pack 6 or later</td>
<td>NetWare 5.1</td>
</tr>
<tr>
<td>Windows 2000/2003 Server with Active Directory* (one domain at a time)</td>
<td>NetWare 6.0</td>
</tr>
<tr>
<td></td>
<td>NetWare 6.5</td>
</tr>
<tr>
<td></td>
<td>Novell Open Enterprise Server (OES) on NetWare</td>
</tr>
<tr>
<td></td>
<td>Novell Open Enterprise Server (OES) on Linux (NSS™ volumes only)</td>
</tr>
</tbody>
</table>

Note that the Server Consolidation Utility accepts Windows 2000/2003 Active Directory domains, as well as Windows NT 4.0 domains, as sources. However, you can consolidate data from only one Active Directory domain at a time.

The Windows workstation (or server) where you run the Server Consolidation Utility must be a registered member of the domain.

Drag-and-Drop Modeling

With the Server Consolidation Utility, you model your consolidation project using drag-and-drop procedures.

The utility’s main project window displays the source tree on the left-hand side and the destination tree on the right-hand side. To model your project, you simply drag folders or entire volumes from the source pane and drop them to the desired location in the destination pane. This gives you a visual representation of how the data will be organized on the destination servers.

*Not supported when consolidating data to OES Linux servers
No data is actually copied during the modeling phase, so you are free to rearrange the data structure until you are satisfied with it.

When you are ready to proceed with the data copy, the Server Consolidation Utility performs a pre-copy verification of the project. This helps prevent errors from interrupting your server consolidation and allows you to correct mistakes before data is copied to the destination servers.

**Server Consolidation Scenarios**

The benefits the Novell Server Consolidation Utility provides can be better understood through examining two consolidation scenarios.

**Basic Server Consolidation: Many-to-One**

In the first scenario, suppose you have three existing NetWare servers. You recently purchased a multiprocessor server that you want to install NetWare 6.5/Open Enterprise Server on to take advantage of NetWare’s multiprocessor-enabled features. You want to copy the data from each of the three servers to the single NetWare 6.5 server. Rather than manually moving all the data and Printer Agents, or backing up the data on each of the three servers and then restoring it to the NetWare 6.5 server, you can use the Server Consolidation Utility to automate the process.

The following figure shows how this consolidation scenario might look.

**Figure 1 Many-to-One Server Consolidation**

Although Figure 1 shows the servers all in the same eDirectory tree, the Server Consolidation Utility lets you do tree-to-tree consolidations as well.

**Consolidating Data from Multiple Servers onto a Two-Node Cluster**

In the second scenario, suppose you have five existing NetWare servers. You recently purchased two multiprocessor servers and the necessary hardware to create a two-node cluster complete with an attached Storage Area Network (SAN). You have decided to install NetWare 6.5 on the two-node cluster because NetWare 6.5 comes with Novell Cluster Services™ software and a two-node cluster license. You want to copy the data from each of the five servers to the SAN on the two-node cluster. Rather than manually moving all the data and Printer Agents or backing up the data and restoring it to the SAN, you can use the Novell Server Consolidation Utility, which automates the data migration process.
The following figure shows how this consolidation scenario might look.

**Figure 2  Cluster Server Consolidation**

Cross-Platform Data Consolidations

As mentioned previously, the Server Consolidation Utility lets you copy data from Windows servers in Windows NT domains or in Active Directory (one domain at a time).

If you have Novell Open Enterprise Server, you can use the Server Consolidation Utility to copy data between the following server platforms:

- NetWare to NetWare
- NetWare to OES Linux
- Windows NT/Active Directory to NetWare
- Windows NT/Active Directory to OES Linux

What’s Next


See Chapter 3, “Preparing for a Server Consolidation,” on page 15 for instructions on how to install the Server Consolidation Utility and prepare your servers for a consolidation project.
What’s New

This chapter lists the new features and enhancements in recent versions of the Novell® Server Consolidation Utility. Novell recommends that you use the latest release.

Product History

Server Consolidation Utility 4.0

Server Consolidation Utility 4.0 adds two significant new features:

- You can consolidate data from NetWare® and Windows® servers to Open Enterprise Server (OES) servers running on either NetWare 6.5 or SUSE® LINUX Enterprise Server 9. The destination server must have the NCP™ Server component installed, and destination volumes must be Novell Storage Services™ (NSS) volumes.
- When consolidating file system data from NT servers, the Server Consolidation Utility now copies ownerships for NTFS files and folders in addition to copying the permissions.

Server Consolidation Utility 3.0

Version 3.0 includes two new features.

- A new command line option is available for scheduling the utility to run at a predetermined date and time. Adding an N after the passwords instructs the utility to skip the Error and Success Log review dialog and simply exit the application after it finishes.
- Novell ZENworks® 6.5 creates an NT Roaming Profile directory the first time an NT user logs into his or her eDirectory account on NetWare. The time-consuming process of having the Server Consolidation Utility copy the NT Profile directory is no longer needed and has been removed.

Server Consolidation Utility 2.6

New features in version 2.6 let you:

- Exclude specific file types or filenames from the copy process
  For example, copy all of the data from a volume except for any .mp3 files.
- Automatically compare file information between the source and destination after the copy process completes to validate the integrity of the file copy
  This includes the option of doing a detailed binary (byte-by-byte) comparison.
- Check for sufficient disk space on the destination server before beginning the file copy
- Disable login on the source server during the copy process
- Specify a default server and home directory path for any new users you create on the destination server
- Copy an expanded list of user attributes when creating users

**Server Consolidation Utility 2.0**

With version 2.0, you could copy volumes and specific directories between different eDirectory trees, as well as consolidate to NetWare 6.5. Version 2.0 also let you:

- Copy data from NT* 4.0 Domains to NetWare
- Schedule projects and run them completely unattended
- Filter the files you want to copy based on date
- Add users to Novell eDirectory on the destination tree if they don’t already exist
- Copy data to the Novell Nterprise™ Branch Office™ Appliance

**Server Consolidation Utility 1.0**

With NetWare Server Consolidation Utility version 1.0, you could copy entire volumes and specific directories between NetWare 4, NetWare 5, and NetWare 6 servers in the same eDirectory™ tree.

**What’s Next**

See Chapter 3, “Preparing for a Server Consolidation,” on page 15 for instructions on how to install the Server Consolidation Utility and prepare your servers for a consolidation project.
Preparing for a Server Consolidation

To install the Novell® Server Consolidation Utility and prepare your source and destination servers for a consolidation project, complete the tasks in the following sections:

- “Meet System and Software Requirements” on page 15
- “Install the Server Consolidation Utility” on page 16
- “Prepare the Source and Destination Servers” on page 16
- “Tips for Successful Consolidations” on page 19
- “Scheduling a Consolidation Project to Run at a Later Time” on page 19
- “What’s Next” on page 21

Meet System and Software Requirements

The Server Consolidation Utility runs on a Windows® workstation on the network. This workstation must meet the requirements outlined in this section.

Workstation Requirements

- Windows 2000 (with Service Pack 3 or later) or Windows XP® Professional Edition
  
  **NOTE:** If you have Windows XP Professional Service Pack 2, you will see an error stating that the Server Consolidation Utility software has not been digitally signed when you run the installation program. You can safely ignore this message and continue installing the utility.

- 50 MB of available disk space

- Novell Client™ for Windows 2000/XP version 4.91 or later
  To check the Novell Client version, right-click the N icon on the workstation toolbar, then click Novell Client Properties > Client. To download the latest client, see the Novell Downloads page (http://www.novell.com/download).

- (Conditional) IPX™ protocol support
  If you are copying data from NetWare 4 servers, you must configure the Novell Client software to support IPX. See the Novell Client Readme for more information.

- Microsoft Data Access Components (MDAC) 2.8
  If MDAC 2.8 is not installed on your workstation, it can be downloaded from the Microsoft Download Center (http://www.microsoft.com/downloads).

- Disable any antivirus programs running on the workstation. You can re-enable virus protection after the consolidation project is completed.
For NetWare projects, you must be logged in as a user with the Supervisor right to the source and destination servers.

Use ConsoleOne® to verify that you have the necessary rights to access all source and destination servers.

For Windows projects, you must be logged in as a user with administrative rights to the domain containing the source server and workstation.

You need the Write/Modify permission to the domain and the Registry of the Primary Domain Controller (PDC).

You also need the Read permission to all folders and files you are copying.

**TIP:** For Windows 2000/2003 consolidation projects, you can run the Server Consolidation Utility on the Windows server itself. This is the preferred method, especially if you have data that uses extended ASCII (multinational characters) or double-byte character sets (Japanese, Korean, and other oriental languages). You cannot run the Server Consolidation Utility on Windows NT servers.

If you have extended ASCII or double-byte character set data on a Windows source server and you plan to run the Server Consolidation Utility on a separate Windows workstation, the workstation must have Windows installed with the same language as the server. For example, if you are migrating a Japanese server, make sure that your workstation is also running Japanese. You must also enable UTF-8 support in the Novell Client.

**Install the Server Consolidation Utility**

The Novell Server Consolidation Utility is located on NetWare 6.5 CD 1 (Operating System) in the products\Migration_Utilities directory. The self-extracting file is named nwsc.exe.

You can also install the version on the CD through the Consolidate Servers option in the Novell Deployment Manager utility. See “Prepare the Network with Deployment Manager” in the OES for NetWare Installation Guide for more information.

The latest version can be downloaded from the Novell Downloads page (http://www.novell.com/download). Novell recommends that you use the latest version whenever possible.

To install the Server Consolidation Utility on the workstation, double-click the nwsc.exe file and follow the on-screen installation instructions.

**TIP:** There are some known issues with Java and certain video cards that cause the Server Consolidation Utility installation to quit after extracting. If you encounter this issue, update your graphic card drivers to the latest version, or disable the hardware acceleration for your graphics card.

**Prepare the Source and Destination Servers**

Before you run the Server Consolidation Utility, you must prepare the source and destination servers by completing these steps.

1. Ensure that all source and destination servers are running supported versions of NetWare, Linux, or Windows server software.

   See “Types of Server Consolidation Projects” on page 9 for more information on supported server operating system versions.

2. Apply the latest NetWare or Open Enterprise Server (OES) Support Packs on both source and destination NetWare or OES servers.

   Updates are available for specific NetWare and OES versions at the Consolidated Support Pack home page (http://support.novell.com/tools/csp).
3 If copying data from and to NetWare servers, set the same code page for both the source and destination servers.

**IMPORTANT:** If both servers don’t have the same code page, data will be lost during the consolidation. For instructions on changing your server’s codepage, see Appendix A, “Changing the NetWare Server Code Page,” on page 63.

4 As a precaution, you should have a current backup of all data on the destination servers.

You should also back up the eDirectory information on the destination servers.


You should have a current backup of the source servers, even though the source data is not modified during a data consolidation project. The only time data is changed on the source server is when you are consolidating printers.

5 For NetWare/eDirectory consolidations, load the latest Storage Management Services™ (SMS) Storage Management Data Requestor (smdr.nlm) and Target Service Agent (tsafs.nlm) modules on your source and destination NetWare servers.

These SMS modules are provided with the NetWare operating system software. To load the modules, type `load smdr` and `load tsafs` at the server console.

If you are consolidating data to OES Linux servers, load the SMS modules as directed in “Installing and Configuring SMS” in the Storage Management Services Administration Guide.

6 Depending on how you have set up service discovery on your network, you might need to add the source server’s IP address, DNS name, and localhost name to the `sys:/etc/hosts` file on the destination server, and vice versa.

See “Troubleshooting” on page 57 for help in resolving server communication problems.

### Preparing NetWare 4 Source Servers

If you are planning to copy data from NetWare 4 source servers, complete these steps in addition to the ones in the previous section. (Keep in mind that you cannot copy data from NetWare 4 servers to OES Linux servers.)

1 The source and destination servers must see each other via IPX.

   For information on verifying IPX communication between servers, see “Errors When Connecting to a NetWare 4 Server” on page 59.

2 Install long name space support on each volume containing data to be copied.

   To add long name space support to a NetWare 4.10 volume, enter

   ```
   load os2.nam
   ```

   and then

   ```
   add name space os2 volume_name
   ```

   at the server console. Replace `volume_name` with the name of the volume.

   To add long name space support to a NetWare 4.11 or 4.2 volume, enter

   ```
   load long.nam
   ```

   and then
add name space long volume_name

at the server console. Replace volume_name with the name of the volume.

3 If you plan to copy compressed data from a NetWare 4 source server, enter the following command at the server console prompt:

set convert compressed to uncompressed option=0

Setting this parameter to 0 leaves compressed files compressed when they are accessed. This prevents compressed files from uncompressing and taking up all of your destination server’s disk space when they are accessed. (Setting the option to 1 changes compressed files to uncompressed on second access, and setting the option to 2 always changes compressed files to the uncompressed version.)

To view your server’s current Convert Compressed to Uncompressed Option SET parameter, execute the SET command at the server console prompt, select the File System category, and then page through the information until you see Convert Compressed to Uncompressed Option.

Modifying the Hosts File

The Server Consolidation Utility connects the servers involved in a consolidation using one of two methods: SLP or the sys:etc\hosts file. If you don’t have SLP configured on your network, you must modify the sys:etc\hosts file to include the IP address and server name of every source server involved in the consolidation project. This information must be manually added to the file before running the Server Consolidation project.

Because Nterprise™ Branch Office™ does not configure SLP, consolidations to Nterprise Branch Office appliances must use information in the hosts file.

IMPORTANT: The Nterprise Branch Office appliance reconfigures itself each time it is restarted. This causes the sys:etc\hosts file on the appliance to be rewritten each time it is restarted. If only one consolidation is being run with an Nterprise Branch Office appliance, the hosts file needs to be modified only once to include the source server’s IP address and server name. However, if more than one consolidation is going to be run on an Nterprise Branch Office appliance and the appliance has been restarted since the last consolidation, the hosts file must be modified each time the appliance is restarted.

You can modify the hosts file from the server/appliance console or from the client workstation.

From the Server Console

1 At the server console, enter

   edit

2 Press Insert.

3 Select sys:, then press Enter.

4 Select etc, then press Enter.

5 Select hosts, then press Enter > Enter.

6 Add to the file the IP address and server name of every source server involved in the consolidation project.

   Type the IP addresses and server names as xxx.xxx.xxx.xxx Server_Name.

7 Save the file.
From the Client Workstation

1. Launch Windows Explorer.
2. Browse to the NetWare server or Nterprise Branch Office appliance.
3. Double-click the server name.
4. Double-click the sys: volume.
5. Double-click the etc directory.
6. Open the hosts file with a text editor.
7. Add to the file the IP address and server name of every source server involved in the consolidation project.
   Type the IP addresses and server names as xxx.xxx.xxx.xxx Server_Name.
8. Save the file.

Tips for Successful Consolidations

- When you run the Server Consolidation Utility, you must be logged in to the network as a user with Supervisor rights to the source and destination servers. If you are not logged in when you start the utility, you can log in as you select the source and destination trees.
- For better performance, Novell recommends that the source servers, destination servers, and client workstation all be located on a common LAN segment.
- For Windows NT server consolidations, you should use the fastest workstation available to run the Server Consolidation Utility. If possible, assign the workstation a static IP address. Turn off screen savers and power management to avoid interruptions during the consolidation.
- When using the Server Consolidation Utility to copy data from a compressed volume to an uncompressed volume, ensure the destination server has enough space left in the volume to accommodate the uncompressed data. Decompression requires some disk space to decompress the file on the source and copy it. Having a small amount of space left on the source system might result in a server abend or unwanted behavior in the file system.

Scheduling a Consolidation Project to Run at a Later Time

The Server Consolidation Utility lets you schedule projects to run when they are most convenient. This means that you can create a consolidation project during the day and schedule it to run during the night when there is a smaller chance that files that are to be moved will be open and being worked on.

The Server Consolidation Utility uses the Scheduled Tasks capability built into Windows to schedule a consolidation project to run at a time that is most convenient to you.

**TIP:** Before scheduling a consolidation project, Novell recommends that you complete the verification process and resolve all errors. When you have verified the project, resolved any errors, and reached the Start Novell Server Consolidation Utility dialog box, then the project can be scheduled.

To schedule a project to run at a later time:

1. Ensure that a Server Consolidation Project has been created.
   Write down the project name and path of its location for later reference.
2 Click Start > Settings > Control Panel.
3 Double-click the Scheduled Tasks icon.
4 Double-click the Add Scheduled Task icon.
5 When the Scheduled Task Wizard launches, click Next.
6 Select the Novell NetWare Server Consolidation Utility from the list of programs provided, then click Next.
7 Assign the scheduled task a name, select its frequency, then click Next. You can run a project as often as you want.
8 Select the start time and date for the project to run, then click Next.
9 Enter the Windows username and password of the user that will perform the task, then click Next.
10 Verify that the time displayed for running the project is correct. If it is, check the Open Advanced Properties for This Task When I Click Finish check box, then click Finish.
11 After the Advanced Properties dialog box opens, click Task.
12 In the dialog box that opens, complete the Run field.
   The dialog box is populated with a pathname that ends in \fc.exe. Add the following parameters, separated by a single space, to this pathname for the scheduled consolidation project to run:
   ✦ (Required) The pathname, in quotation marks, to the consolidation project that you are scheduling to run. For example:
     "c:\my projects\sc1.mdb" (where sc1.mdb is the saved project)
   ✦ (Required) The letter Y, to automatically run the selected Server Consolidation project.
   ✦ (Required) The password for the admin on the source server.
   ✦ (Required) The password for the admin on the destination server.
   ✦ (Optional) The letter N, to skip the Error and Success Log review dialog and simply exit the utility after it finishes.

When completed, the Run field of the Advanced Properties dialog box should look similar to this:

```
c:\program files\novell\netware server consolidation utility\fc.exe "c:\my projects\sc1.mdb" y
```

In the previous example, c:\program files\novell\netware server consolidation utility\fc.exe is the pathname that was already in the Run: field of the dialog box, "c:\my projects\sc1.mdb" is the saved project that is scheduled to run, y is the Yes parameter to automatically run the project, test1 is the admin password on the source server, and test2 is the admin password on the destination server.

13 After entering the parameters, click OK.
14 In the dialog box that appears, enter the Windows username and password of the admin running the project, then click OK.
   The Server Consolidation project will run at the scheduled time.
What's Next

If you are consolidating data within a NetWare or Nterprise Branch Office environment, go to Chapter 4, “Consolidating Data from NetWare Servers,” on page 23.

If you are consolidating data from a Windows NT environment to NetWare, go to Chapter 5, “Consolidating Data from Windows Servers,” on page 41.

If you are consolidating data to a Novell Open Enterprise Server (OES) Linux server, go to Chapter 6, “Consolidating Data to OES Linux,” on page 49.
4

Consolidating Data from NetWare Servers

The Novell® Server Consolidation Utility is a Windows program that is launched from the Start menu. It has a helpful interface that guides you through each step of the process.

To launch the utility, click Start > Programs > Novell Server Consolidation Utility > Novell Server Consolidation Utility. Then complete the following tasks:

1. Understand NetWare Server Consolidation Issues (page 23).
2. Create a Project File (page 24).
3. Select a Source and Destination Tree (page 25).
5. Perform Pre-Copy Verifications (page 27).
7. Run the Consolidation (page 35).

In addition, this chapter contains information on the following optional tasks:

1. Consolidating Data to or from a NetWare 5.1 Cluster (page 35).
2. Consolidating Data to Nterprise Branch Office (page 36).
3. Consolidating Data from NetWare 4 Servers (page 38)

Understand NetWare Server Consolidation Issues

Before running a consolidation project in a NetWare®/eDirectory™ environment, be sure you have prepared your server as described in “Prepare the Source and Destination Servers” on page 16.

You should also be aware of the issues discussed in this section.

Open Files Cannot Be Copied

The Server Consolidation Utility cannot copy files that are open and currently in use.

There is one exception to this rule. NSS has a feature called File Copy on Write. This permits a file that is being changed to be accessed in the same state as it was in when it was last closed by all processes.

This feature is enabled on an NSS volume either by using ConsoleOne® or entering

\texttt{nss /filecopyonwrite=volname}

at the source server console to change the volume attributes.
For example, `nss /filecopyonwrite=voll` would enable File Copy on Write for the voll: volume. The effect is immediate, but it affects only files that are currently closed and then opened later.

**Cluster Failover Stops File Copy**

If you run a Server Consolidation Utility project involving a NetWare cluster and the cluster fails over during the consolidation, the file copy will stop. The Server Consolidation Utility project must be run again.

**Consolidating NDPS Printer Agents**

If you plan to consolidate NDPS™ Printer Agents as part of a NetWare/eDirectory consolidation, be aware of the following points:

- Because the Server Consolidation Utility actually moves the Printer Agents, you should back up your source server before launching this operation. If you make a mistake in moving a Printer Agent, wait until it is fully functional in its new location before you move it back.
- The Server Consolidation Utility does not move Print Brokers or Print Managers. If you want to move a Print Broker, you must first create a new broker on the target server, copy the contents to the new server (perform the consolidation), and then delete the old broker.
- Printer Agents can be moved; print queues cannot.
- Printer Agents that are moved still use the same Print Broker.
- Printer Agents can be moved only within the same tree. They cannot be moved between different trees.
- Print Services Managers must be operational during the consolidation.
- After moving Printer Agents from the source to the destination server, unload the source Print Services Manager so the migrated Printer Agents can establish a connection to the destination Print Services Manager.

**TIP:** After unloading the source Print Services Manager, send a test print job to the printer that was moved. This ensures that communication with the destination Print Services Manager is established. After that communication has been established, the source Print Services Manager can be brought back up.

- You might need to manually load or reload the appropriate tsa.nlm or smdr.nlm.

**Create a Project File**

The Server Consolidation Utility uses a project (.mdb) file to record your intended actions. The actions are recorded so you can execute them now or save the project file and execute the actions later.

The filename can be up to 64 characters long and can include any character except \* ? < > " /.

You have the option to:

1. Create a new project.
2. Open an existing project.
3. Open the last project you worked on.

To create a project file, complete the following steps:
1 In the Startup dialog box, click the radio button next to the selection you want.
2 Click OK.
3 (Conditional) If you choose to create a new project, you are prompted to select the source type. The choices are:
   - NetWare NDS/eDir Tree
   - Microsoft* Windows Domain
3a In the Project Type dialog box, click the radio button next to the selection you want.
3b Click OK.
   If you choose to create a new project, you are prompted to view the setup tasks for the utility and to verify that you have met the requirements before continuing.
4 Click Next.
   After performing the setup tasks for the utility, you must name the project and specify the location on the workstation where the project file is to be stored.
5 Type a project filename in the field provided.
6 (Conditional) If you want to store the project file in a location other than the default location provided, click Browse.
7 Click Next to select a source and destination tree.

Select a Source and Destination Tree

After you create a project file, the Startup dialog box is displayed. The Server Consolidation Utility allows you to move volumes and directories between servers in either the same tree or between different trees. However, in order to do this, you must be logged in to the trees that you will be working in.

1 Select the source and destination eDirectory™ (NDS) tree from the drop-down list provided or click Login to browse to a tree that is not in the drop-down list.
   Only trees that you are currently logged in to are available on the drop-down list.
1a (Conditional) In the Novell Login dialog box, click Trees.
1b Browse to each desired tree and log in with the correct username and password.
   If you do not know the tree name, in the Server field of the Login dialog box, type the IP address or DNS name of the server that you will be consolidating to or from.
   IMPORTANT: If you are performing a consolidation to an Nterprise Branch Office appliance, the Admin user’s context is always appusers.
1c Click OK.
2 Click Next.
3 In the Startup dialog box, click Create to finish creating the project file.

Model Your Consolidation Project

The Project Window (see Figure 3 on page 26) is where you select which volumes and directories to copy and which Printer objects to move. The Project Window is divided into two panes that each show the trees that you are working in.
You drag objects from the left pane and drop them into the right pane. You select volumes and directories to copy to different servers, and Printer Agents to move to different Print Managers.

Figure 3 Project Window Post-Copy View

Dragging and Dropping Volumes

When you drag-and-drop volumes into the right pane of the Project Window, a Volume Drop Options dialog box displays. You must choose to either migrate the volume contents into the directory or volume that you selected or create a new directory with the name of the volume that is being moved.

1. Click the radio button next to the option you want.
2. Click OK.

Dragging and Dropping Folders

If you drag-and-drop a folder onto a destination folder of the same name, a Duplicate Folder Options dialog box displays. You have several options:

- Don’t Copy the Directory - The directory on the source server is not copied and the directory on the destination server is not replaced.
- Merge Directory Contents - The contents of the source directory are merged into the destination directory with the same name.
- Rename - The directory on the source server is copied to the destination server with a new name assigned to it. You must enter a new name in the field provided if you select this option.
- Merge All - If you are dragging-and-dropping multiple directories at once, select this option if you want to merge the contents for all duplicate directories.

1. Click the radio button next to the option you want.
2. Click OK.
Navigating the Project Window

In addition to dragging-and-dropping objects, you can perform several other tasks from the Project Window menu:

- Save project settings: Click File > Save As.
- Move created and dropped objects around by dragging them to the desired location.
- Create a new container or folder: Select the parent container or existing folder in the right pane, then click Edit > New Folder.
- Cancel a "dropped" action: Select the volume or directory in the right pane, then click Edit > Back Out.
- Rename a newly created container or folder: Select the parent container or existing folder in the right pane, then click Edit > Rename.
- Show where a folder or object went: Select the object in the left pane, then click Edit > Where Did It Go. The directory or volume that was moved is highlighted in its new location in the right pane.
- Show where a folder or object came from: Select the object in the right pane, then click Edit > Where Did It Come From. The directory or volume that it came from is highlighted in the left pane.
- Show all folders or objects selected for copying: Select a container in the left pane, then click Edit > Show Dropped Folders [or Show Dropped Printers].

TIP: The previous six tasks can also be performed by right-clicking the object to see the same menu option.

- View the available disk space prior to performing the verification by right-clicking the destination volume in the right pane of the Project Window and then selecting Properties. Right-clicking the source folder or volume in the left pane of the Project Window and then selecting Properties displays the size of the source object.

Creating containers and dragging-and-dropping objects in the Project Window does not immediately perform the action. It only creates a preview of where the files and objects will reside. The actions are completed only after the verification process is complete and the copy process begins.

Perform Pre-Copy Verifications

After you have dragged-and-dropped the selected directories or volumes and have performed any other setup tasks, proceed by clicking Project > Verify and Copy Data or by clicking Do the Consolidation on the button bar. The Verification Wizard displays.

Begin the Verification

1. Click Next to begin the verification process.

The Dropped Folders dialog box displays, showing the source path and destination path for the dropped folders.

2. Do one of the following:
   - If the source and destination paths are correct, click Next.
   - If the source or destination path is incorrect, click Cancel and make the appropriate changes in the Project window.
If you created new folders in the right pane of the Project window as part of your consolidation project, the Created Folders dialog box now displays.

3 (Conditional) If prompted with the Create Folders dialog box, do one of the following:
   • If the destination path of the created folders is correct, click Next.
   • If the destination path is incorrect, click Cancel and make the appropriate changes in the Project window.

The Duplicate File Resolution dialog box displays.

**Duplicate File Resolution Options**

If a file is found on the destination volume or directory that has the same name as a file being copied from the source, you must decide what to do. You have three options to choose from on the Duplicate File Resolution dialog box:

   • Don’t copy over existing files
     The file on the source server is not copied and the file on the destination server is not replaced.
   • Copy the source file if it is newer (Default)
     If the file on the source server is newer than the one on the destination server, the file on the destination server is replaced.
   • Always copy the source file
     The file on the source server always replaces the file with the same name on the destination server.

1 Click the radio button next to the option you want.
2 Click Next.

The Synchronize Files and Folders dialog box now displays.

**Synchronize Files and Folders**

In the Synchronize Files and Folders dialog box, you have the option to delete files and folders on the destination server that do not exist on the source server. Selecting Yes deletes all files and folders on the destination server that are not on the source server. No is the default selection.

1 Click the radio button next to the option you want.
2 Click Next.

The Compare Files and Folders dialog box now displays.

**Compare Files and Folders**

In the Compare Files and Folders dialog box, you have the option to compare files and folders between the source and destination servers after the copy process completes. Selecting Yes compares the following information between the source and destination files and folders:

   • Names
   • Dates
   • Sizes
   • Attributes
   • Trustees
 Owners

If you select Yes, you are given the option of doing a binary comparison of the files after the copy process completes. A binary (byte-by-byte) comparison gives the greatest assurance that two files are identical, but it takes longer to complete.

1 (Conditional) If you do not want to compare source and destination files after the copy process, click the No radio button.

2 (Conditional) If you want to compare source and destination files after the copy process, click the Yes radio button.

3 If you selected Yes in the previous step and if you want to perform a binary comparison of the files that were copied, check the Binary Comparison check box.

4 Click Next.

The File Date Filters dialog box now displays.

Copy Files Based on Dates

In the File Date Filters dialog box, you have the option to copy files based on dates and three separate attributes:

- Accessed
- Modified
- Created

If No is selected in this dialog box, all files are copied. If Yes is selected, date ranges can be entered for the file copy. You can select as many criteria as you would like, and only those files that meet all of the selected criteria are copied.

Two dates can be set for each attribute. The first date is an On or After date and the second is an On or Before date. For example, if you only check the On or Before check box and set the date for November 10, 2000, for the Accessed attribute, only those files accessed on or before November 10, 2000, are copied. In the same example, if you also check the On or After check box and set the date to October 1, 2000, only those files accessed on or after October 1, 2000, and on or before November 10, 2000, are copied.

1 (Conditional) If you do not want to filter files based on dates, click the No radio button.

2 (Conditional) If you want to filter based on dates, do the following:

2a Click the Yes radio button.

2b Check any of the available check boxes for the desired combination of file types and dates.

To change the date from the default provided, check the box next to the desired date. Next, highlight with your mouse the portion of the date you want to change. Either type a new value using the keyboard number pad, or use the mouse to click the Up-and Down-arrows provided to the immediate right of the date field.

3 Click Next.

The Wildcard Selection dialog box now displays.
Wildcard Selection

In the Wildcard Selection dialog box, you have the option to exclude specific file types or file names from the copy process.

A wildcard is a character that can be used to represent one or more characters in a search. The two most commonly used wildcards are

- The question mark (?)
  Used to represent a single alphanumeric character in a search expression.
  For example, excluding the file te?t.txt would exclude tent.txt, test.txt, and text.txt from the copy process.

- The asterisk (*)
  Used to specify zero or more alphanumeric characters in a search expression. For example, excluding the file h*s.txt would exclude house.txt, his.txt, horses.txt, and happiness.txt from the copy process.

1 Type the file extension types or filenames in the field provided. For multiple filenames or types, press Enter between each entry. Wildcards (*) are permitted.

For example, if you want to exclude a specific file named test.txt from being copied, type test.txt in the field provided. If you want to exclude all .mp3 files from being copied, type *.mp3 in the field provided.

Type as many filenames or file extension types as you want. Separate the filenames or file extensions by pressing Enter between each entry. Do not use spaces or commas to separate the entries. See the following examples:

Correct:
- *.mp3
- test.txt
- *.wav

Incorrect:
- *.mp3 test.txt *.wav
  or
- *.mp3, test.txt, *.wav

2 Click Next.

If you are performing a consolidation between servers in different trees, the Check for Trustees and Ownerships dialog box now displays. If you are performing a consolidation between servers in a single tree, proceed to “Verify Password” on page 23.

Check for Trustees and Ownership

When you copy data from one tree to another, the Server Consolidation Utility searches the destination tree for objects whose names match the source tree object names. Objects that are potential matches are displayed and can be matched up during “Match Up Tree Objects” on page 32.

If this option is enabled, the Server Consolidation Utility scans the dropped folders and their subordinates for trustees and owners. This check must be performed the first time a consolidation is run. If a consolidation is run a second time, this scan does not need to be repeated, as long as
trustees have not been added to the source server and new directories or folders have not been dropped onto the destination server. If either has happened, another scan is necessary. This trustee and ownership check slows down the verification process.

**NOTE:** If a file has already been copied to the destination server or tree, that file’s trustees are not updated during the consolidation unless the source file data is recopied. See “Duplicate File Resolution Options” on page 28 for information about when a source file might overwrite the destination file.

1. Click Browse to select the destination container you want to search.

2. Check the Search All Subordinate Containers check box to search all containers in the destination tree below, and including, the one you selected.

   Leaving the box unchecked searches only the selected destination container. For better performance, limit the search to the container that you believe the object resides in. Searching from Root takes significantly longer depending on the size of the destination tree.

3. Click Next.

If consolidating data to an Nterprise Branch Office appliance, there is not an option to specify the container you want to search. Click the Yes or No radio button, then click Next.

The Password Verification dialog box now displays.

**Verify Password**

1. In the Password Verification dialog box, enter the passwords for the source and destination trees in the fields provided.

   **NOTE:** SMS is the backup and copy engine used by the Server Consolidation Utility. You enter your password here because SMS requires that the servers involved in the consolidation be authenticated to each other.

2. Click Next.

The Novell Server Consolidation Verification dialog box now displays.

**Check for Sufficient Disk Space and Disable Login**

Before beginning to consolidate your data, you can verify that your destination volumes have enough space to accommodate the data that will be moved. Verifying disk space can be a long process if you have many files to copy.

You can also disable login on the source server before copying file data. Users already logged in to the source server are not logged out, but no new logins are allowed until the consolidation completes. If you disable login and the workstation running the consolidation project crashes for any reason during the consolidation, you might have to manually re-enable login on the source server console.

1. To verify the available space on the destination volumes, check the Check for Sufficient Disk Space check box

2. To have the utility disable login on the source server prior to copying data, check the Disable Login check box

3. To begin the verification prior to copying the files and moving the printers, click Next

During the verification process, you might see a message informing you that an updated tsa.nlm or smdr.nlm must be copied for the consolidation to work. Click Yes to continue the project verification. Clicking No stops the consolidation.
Resolve Errors

If there were errors discovered in the verification attempt, they will be shown in the Error Resolution dialog box. Errors could include name conflicts, insufficient rights, required name spaces not loaded, and insufficient disk space.

Errors found during the verification process are classified as follows:

- Errors must be resolved before files can be copied.
- Warnings should be resolved but might not affect the copy process.

In addition, the Error Resolution dialog box might display informational text classified as follows:

- Information about the decisions you made in the Project Window.

A description of the error and a possible resolution appears in the Information text box. If no resolution is provided, you can find more information in the Novell Error Code online documentation (http://www.novell.com/documentation/lg/nwec/index.html). (Search the system by error code number.)

After resolving any errors that exist, click Next. If there were no errors, warnings, or informational text to display, and if you are moving objects from one tree to another, the Tree-to-Tree Object Match Up dialog box now displays. If you are not moving objects between trees, proceed to “Run the Consolidation” on page 35.

Match Up Tree Objects

All trustees of copied data that appear in both the source and destination trees are displayed in the Tree-to-Tree Object Match Up dialog box based on their category. These trustees are discovered during the Check for Trustees and Ownership step on page 23 and are saved in the project database.

This screen allows you to match the trustee names found on the source server with trustees from the destination server. If an appropriate match does not exist, you can create an object on the destination server that matches the object name from the source server. You can also browse to an existing object in the destination tree and match it up with the source server object name.

**IMPORTANT:** If you are consolidating to an Nterprise™ Branch Office™ Appliance, see “Consolidating Data to Nterprise Branch Office” on page 36 now.

1. Select the type of objects to display from the drop-down list provided in the Tree-to-Tree Object Match Up dialog box.

2. Check the check box to the left of the object you want to match up.

To select more than one object, press and hold the Ctrl key while checking the check box to the left of the objects that you want to select. You can also check the check box to the left of one object, press and hold the Shift key, then check the check box to the left of a second object to select those two objects and all other objects located between them in the list.

The following attributes are copied for each selected user:

- Common Name
- Description
- E-mail Address
- Fax Number
• Full Name
• Generational Qualifier
• Given Name
• Initials
• Internet E-mail Address
• Language
• Locality Name
• Lockout After Detection
• Login Allowed Time
• Login Disabled
• Login Expiration Time
• Login Grace Limit
• Login Grace Remaining
• Login Intruder Limit
• Login Maximum Simultaneous
• Login Script
• Mailbox Location
• Network Address Restriction
• Organizational Name
• Organizational Unit Name
• Password Allow Change
• Password Expiration Interval
• Password Expiration Time
• Password Minimum Length
• Password Required
• Password Unique Required
• Physical Delivery Office name
• Post Office Box
• Postal Address
• Postal Code
• State or Province Name
• Street Address
• Surname
• Telephone Number
• Title
2a (Conditional) If you selected more than one object, right-click on the selected objects and then click Create All Selected Objects.

2b (Optional) If you want to create objects for all of the selected objects, click the Yes radio button.

2c To select the container that the objects will be created in, click Browse.

2d Click OK.

2e To unmatch more than one object, select the desired objects, right-click the objects, and then click Unmatch All Selected Objects.

3 From the drop-down menu under the Destination Object heading, select the option you want:
   • The object in the destination tree that has the same name as the object in the source tree
   • Don’t match (object doesn’t exist in the destination tree)
   • Browse
   • Create

4 (Conditional) If you selected Browse in Step 3, do the following in the Context Browser dialog box:
   4a Select a matching object.
   4b Click OK.

5 (Conditional) If you selected Create in Step 3, do the following in the Object Creation dialog box:
   5a To browse to the container that the new object will be created in, click Browse.
   5b Select the container.
   5c Click OK.
   5d Type the new object’s name in the field provided, then click OK.
   5e Repeat Step 5d for each object you want to create.

**NOTE:** When the Server Consolidation Utility creates a new user, it assigns a random password to that user. The username and the randomly assigned password are written to the success log. This log file can be viewed after the consolidation completes.

The Server Consolidation Utility allows you to create groups if they don't already exist in the destination tree and it adds the users that are members of the source group to the new destination group. However, it does not modify an existing group. If you use the utility to create a group in the destination tree and then add additional members to the source tree’s group, those added members are not added to the destination group. Also, if you choose to create the groups manually (on the destination) rather than using the Server Consolidation Utility, and then you attempt to match up the groups during the consolidation, the group members are not transferred.

6 When you have finished matching all the objects, click Next.

7 (Conditional) If you have unmatched objects, do one of the following in the Unmatched Objects dialog box that displays:
   • To proceed without matching the objects, click Yes.
   • To go back and match up the objects before continuing, click No.

The Default Server and Home Directory for Created Users dialog box now displays.
Default Server and Home Directory for Created Users

In the Default Server and Home Directory for Created Users dialog box, you have the option to assign a default server for all created users. The default server is the server the user gets a connection to during login if the user doesn't request a connection to a specific server. It’s also the server used if the user makes a network request without naming the server, and it’s the server the user still has an attachment to after logging out.

You can also assign a parent directory for any created user’s home directory. A home directory is an optional, single-valued property that specifies the location (volume and path) and name for the user’s working area on the server.

1 (Conditional) If you want to assign a default server for all created users, click the first Browse button.

2 Select a server from the tree.

3 Click OK.

4 (Conditional) If you want to assign a parent directory for any created user’s home directory, click the second Browse button.

5 Select a directory from the tree.

6 Click OK > Next.

The Start Novell Server Consolidation Utility dialog box now displays.

Run the Consolidation

After selecting the objects to copy and resolving critical errors, you can now copy your files by clicking Proceed in the Start Novell Server Consolidation Utility dialog box.

During the copy process, new folders and objects are created, files are copied, and Printer Agents are moved to their destination (as specified in the right pane of the Project Window).

When the copy process is complete, a Process Finished screen displays that lets you

• View the error log.
• View the success log.
• Close the Process Finished screen.

TIP: You can also view the error and success logs of any completed project from the Project Window by opening the project file and clicking View > Error Log or View > Success Log, or by clicking the corresponding button on the button bar.

If you interrupt the copy process before it completes, all objects, directories, and files already copied to the destination server will remain there unless you manually delete them.

Consolidating Data to or from a NetWare 5.1 Cluster

When a volume is cluster enabled, an object is created in eDirectory with the name of the cluster followed by an underscore followed by the volume name. For example, cluster1_vol1. For the Server Consolidation Utility to function properly with a NetWare 5.1 cluster-enabled volume, the server name followed by an underscore followed by the Volume Name object must be used in the Project Window instead. For example, server1_vol1.

This substitution can be accomplished by completing the following steps:
1 Start ConsoleOne, and browse to the context where the NCP™ Server object resides.

2 Right-click the right pane, select NEW/Volume, then type the name of the new object in the first field.

   This should be the server name followed by an underscore followed by the volume name.

3 In the second field, browse and select the appropriate server.

4 In the third field, select the volume from the drop-down menu, then click OK.

5 In the Server Consolidation Utility Project Window, refresh the container where the Volume object is located to make the new object appear.

6 When dragging-and-dropping in the project window, use the newly created Volume object.

   If you use the `clustername_volumename` object instead of creating and using the new Volume object, a critical SMDR error will occur and you won’t be able to complete the consolidation process.

7 After the consolidation is complete, you can delete the newly created Volume object.

### Consolidating Data to Nterprise Branch Office

Novell Nterprise Branch Office is a business office management solution that reduces the costs and challenges of managing and using offices in remote locations. Novell Nterprise Branch Office is appliance software that you can deploy on hardware at remote offices and still have the flexibility to manage from one central location at your corporate offices. Administrators and users access the features they need through the Internet from a Web browser.

Moving directories, volumes, or users and their associated trustees and rights to a new Novell Nterprise Branch Office appliance is a daunting task made easier by the Server Consolidation Utility. Moving information with the Server Consolidation Utility is faster and easier than manually entering individual users, copying files, and manually assigning their rights and trustees on a new Nterprise Branch Office appliance.

The Server Consolidation Utility works with Novell Nterprise Branch Office appliances in much the same way it works with NetWare servers. However, there are a few differences in the way the Server Consolidation Utility runs in relation to Nterprise Branch Office. This section describes the following:

- Unlocking the Nterprise Branch Office Appliance (page 36)
- Performing a Server Consolidation to a Novell Nterprise Branch Office Appliance (page 37)

### Unlocking the Nterprise Branch Office Appliance

In order to perform a consolidation to an Nterprise Branch Office appliance, you must be logged in as Supervisor to the appliance. The Branch Office appliance does not allow supervisor rights unless the server is unlocked. When the server is unlocked, Supervisor is granted supervisor rights and the consolidation can be run.

**WARNING:** Do not use the Admin username and password to unlock the appliance. Doing so can corrupt the encrypted password and require a re-installation of the Branch Office appliance.

1 At the server console, log in by entering the Supervisor username and password.

2 Enter

   `unlock`

3 When prompted, enter `y` for Yes.
To relock the server, enter `lock` at the server console.

Performing a Server Consolidation to a Novell Nterprise Branch Office Appliance

When performing a consolidation to the Nterprise Branch Office appliance using the Server Consolidation Utility, you will see several screens that are different from the ones displayed during a consolidation on a regular NetWare server. The different screens that require navigation are described below.

**Match Up Tree Objects**

The Tree-to-Tree Object Match Up screen displays. Any objects that appear in both the source and destination trees are displayed based on their class. To match up objects in a consolidation involving an Nterprise Branch Office appliance, complete the following steps:

1. Select the type of objects to display from the drop-down list provided.
2. Check the check box to the left of the object you want to match up.

   To select more than one object, press and hold the Ctrl key while checking the check box to the left of the objects that you want to select. You can also check the check box to the left of one object, press and hold the Shift key, then check the check box to the left of a second object to select those two objects and all other objects located between them in the list.

   The following attributes are copied for each selected user:
   - Department
   - Description
   - E-mail Address
   - Fax Number
   - Full Name
   - Given Name
   - Internet E-mail Address
   - Location
   - Postal Address
   - Surname
   - Telephone Number
   - Title
   - Unique IDs

2a (Conditional) If you selected more than one object, right-click the objects and then click Create All Selected Objects.

2b (Optional) If you want to create users for all of the selected users, click the Yes radio button.

2c From the drop-down list, select whether these will be Local Users or Remote Users.

2d Click OK.
3 From the drop-down menu under the Destination Object heading, select the option you want:
   - The object in the destination tree that has the same name as the object in the source tree
   - Don’t match (object doesn’t exist in the destination tree)
   - Browse
   - Create (if you are matching users)

4 (Conditional) If you selected Browse in Step 3, do the following in the Context Browser dialog box:
   4a Select a matching object.
   4b Click OK.

5 (Conditional) If you selected Create in Step 3, do the following in the Object Creation dialog box:
   5a From the drop-down list, select whether you want to create a Local User or Remote User.
   5b Type the new user’s name in the field provided, then click OK
   5c Repeat Step 5a for each user you want to create.

6 When you have finished matching all the objects, click Next.

7 (Conditional) If you have unmatched objects, do one of the following in the Unmatched Objects dialog box that displays:
   - To proceed without matching the objects, click Yes.
   - To go back and match up the objects before continuing, click No.

Refer to “Default Server and Home Directory for Created Users” on page 35 to complete the consolidation.

Consolidating Data from NetWare 4 Servers

NetWare 4 servers use the IPX™ protocol exclusively and do not support TCP/IP communication. Therefore, before running a consolidation project from a NetWare 4 server to a NetWare 5, NetWare 6, or Nterprise Branch Office appliance, you must first bind IPX on the destination server and on the workstation running the Server Consolidation Utility. Otherwise, the consolidation will fail.

NOTE: Because OES Linux does not support IPX, this section does not apply if you are consolidating data to an OES Linux destination server.

Binding IPX on the Server

1 At the server console, enter
   `inetcfg`

2 Select Boards, then press Enter.

3 Press Insert.

4 Select the appropriate network interface, then press Enter.

5 Specify a board name and slot number, then press Esc.

6 Select Yes to save changes, then press Enter.
To return to the main Internetworking Configuration screen, press Esc.

Select Protocols, then press Enter.

Select IPX, then press Enter.

Enable and configure IPX, then exit the INETCFG utility.

**TIP:** If you prefer, IPX can also be enabled on the server by adding the appropriate LOAD and BIND commands to the server's autoexec.ncf file.

### Binding IPX on the Client

1. Insert *Novell Clients Software CD*.
2. Select the client version you want, then click Next.
3. Select the appropriate language, then click Next.
4. Select Custom, then click Next.
5. Select IP and IPX.
6. Click Next > Next > Finish.

### Verifying IPX Is Bound on the Client

1. Right-click the red N on the status bar (system tray) on your workstation.
2. Click Novell Client Properties.
3. Click the Protocol Preferences tab.

   If the Protocol window displays both IP and IPX, the client has IPX bound.

   If the Protocol window displays only IP, then IPX needs to be bound on the workstation.

You can now proceed with your consolidation project.
Consolidating Data from Windows Servers

The Novell® Server Consolidation Utility automates key tasks, such as migrating users and their file permissions, assigning passwords, and migrating the Windows NT file system or Windows 2000/2003 Active Directory domains to a designated eDirectory™ tree. This automation eliminates the need to choose from various utilities that would help you perform these tasks individually.

After you have planned your consolidation by reading through the issues listed below, you’re ready to begin your Windows data migration. Complete the following tasks in the order they are listed.

3. Perform Prerequisite Tasks (page 42).
4. Create a Project File (page 43).
5. Model Your Consolidation Project (page 45).
6. Verify Your Consolidation Project (page 45).
7. Run the Consolidation (page 46).
8. Perform Post-Consolidation Tasks (page 48).

Understand Windows Consolidation Issues

Although many tasks are automated in the Server Consolidation Utility, you should consider the following issues before you get started.

- Which Windows users are accessing which files and directories, and where are those files and directories located?

  This information will help you decide which Windows servers to migrate first and how many servers you will need to migrate at one time. When you migrate your users and groups, you will want to migrate all files and directories that they have access to at the same time that you migrate their User objects.

  **NOTE:** The Server Consolidation Utility migrates only global user accounts in the selected domain. It does not migrate local accounts provided in the domain for users whose regular accounts are in another domain.

- Which NetWare® or Open Enterprise Server (OES) servers and volumes are you going to migrate your Windows server folders to?

  You should plan which servers and volumes in your destination eDirectory tree will receive each of your Windows server folders. You can select a separate location for each folder, if desired. In order to plan effectively, you will need to become familiar with the file structure on the NetWare servers in your destination eDirectory tree.
Which Windows users and groups am I going to migrate? Which eDirectory containers on the destination eDirectory tree am I going to migrate them into?

Decide which Windows users and groups you are going to migrate, then determine whether you will need to create separate containers for your Windows users and groups in the destination eDirectory tree. When you model your migration in the Project Window, you can create any additional eDirectory containers you might need by right-clicking an eDirectory Organizational Unit.

Do any existing eDirectory User objects represent the same person in my Windows domain?

Determine whether any of your Windows users already have an eDirectory account. During the migration you will be asked if you want to search the eDirectory tree for duplicate usernames. When the Server Consolidation Utility finds identical usernames, it will display these in a table where you can choose to merge the listed Windows user with an eDirectory User object.

What will I do with any applications that do not run on NetWare or Open Enterprise Server?

The Server Consolidation Utility does not migrate applications. After the migration, you will have to reinstall your applications on the destination server. If you have some applications that do not run on NetWare or OES, you can keep an Windows server intact and use it as an application server.

How do I want to migrate information about my users and groups? Do I want to use a Template object?

For information, see “Create a Template Object” on page 42.

Do I have any trusted domains?

If so, you must reassign any trusted domain permissions to the appropriate Windows users and groups after the migration is complete. Use ConsoleOne® to reassign all lost trusted domain permissions.

Meet System and Software Requirements


NOTE: Although the Server Consolidation Utility lets you consolidate data from Windows NT servers, you cannot run the utility on Windows NT because the Novell ClientTM software no longer supports Windows NT 4.

See “Workstation Requirements” on page 15 for more information about system and software requirements for running the Server Consolidation Utility.

Perform Prerequisite Tasks

Create a Template Object

The first prerequisite task is to determine whether you want to use a Template object to migrate your NT users to the destination eDirectory tree.

A Template object defines additional eDirectory User attributes for NT users during the migration. We recommend that you use a Template object because it is an organized way to migrate your NT users to the eDirectory tree and manage them after they are there.

IMPORTANT: In order to migrate home directories, you must use a Template object.
If there is a conflict between the properties of a Template object and an NT policy, the properties of the Template object will, in most cases, take priority. For example, if a minimum password length of seven characters is specified for user Jeff in an NT policy and a minimum password length of nine characters is specified in the Template object, then when Jeff’s object is migrated, the object will be created in eDirectory with a password length of nine characters.

If you want to know what additional eDirectory attributes can be defined in a Template object, run ConsoleOne and double-click a Template object to view all of the existing properties.

The last name, full name, and description of every NT object is always migrated and these corresponding properties from the Template object are overwritten.

If you decide to use a Template object, you can create one in ConsoleOne by clicking File > New > Object > Template.

Register the Workstation

Make sure that the workstation running the Server Consolidation Utility is registered within the domain that you want to migrate. If it is registered properly, continue with “Create a Project File” on page 43.

If you want to change the domain that your workstation is registered in, complete the following instructions.

1. At the workstation, right-click My Network Places and then click Properties.
2. Click the Network Identification link.
3. Click Properties, specify the computer name and appropriate domain, then click OK.
4. Reboot the workstation and launch the Server Consolidation Utility again; then continue with the next section, Create a Project File.

Create a Project File

1. Launch the Server Consolidation Utility by clicking Start > Programs > Novell Server Consolidation Utility > Novell Server Consolidation Utility.
2. Click Create a New Project > OK.
3. Click Microsoft Windows Domain > OK.
4. The next screen reminds you about the system requirements and lets you check for software updates.

   Click the View Online Documentation button to view the Server Consolidation Utility documentation in your default Web browser. Make sure you have completed the system and software requirements outlined in the documentation. Then close your browser.

   Click the Check Latest Updates button to launch the Novell Downloads page in your default Web browser. You can search to see if a newer version of the Server Consolidation Utility is available to download. Then close your browser.

   Click Next to continue.

5. Name your consolidation project, select a place to save it, then click Next.

   By default, the Server Consolidation Utility saves your project in c:\Program Files\Novell Server Consolidation Utility.
Verify that the Windows domain that appears in the grayed-out text field is the domain that you want to migrate.

The Server Consolidation Utility automatically displays the domain that your workstation or server is a member of.

You can change the domain that the workstation running the utility is registered in. To do this, exit the utility and follow the instructions in “Register the Workstation” on page 43.

Select your destination eDirectory tree from the drop-down list, then click Next.

The destination eDirectory tree is the eDirectory tree that you want to migrate your Windows server data to.

If you are not logged in to your eDirectory tree, the eDirectory tree name will not appear in the drop-down list. If this is the case, click the Login button to log in to your eDirectory tree. After you are logged in, the eDirectory tree name automatically appears in the drop-down list.

Decide whether you want Server Consolidation to find any User objects in your Windows domain and in the destination eDirectory tree that have the same name, click Yes or No, then click Next.

To create and save your consolidation project, click Create.

When a project is created and saved, the Server Consolidation Utility creates a file that contains the success and error logs of your project; these logs contain the details of what took place during the consolidation.

(Conditional) If you clicked Yes to find User objects with identical names in Step 8, continue with Step 10a to resolve name conflicts. If you clicked No, skip the rest of the steps in this section and go to “Model Your Consolidation Project” on page 45.

To select an eDirectory container on the destination eDirectory tree, click the Browse button.

Browse the tree and select an eDirectory container, then click OK.

To begin searching for duplicate usernames, click Next.

Decide what you want to do with Windows users that have the same name as eDirectory users.

You have the following options for each listed Windows user:

- Merge the Windows user with the displayed eDirectory user. Simply leave that user as it is displayed in the table and continue with the next listed Windows user.

- Merge a Windows user with a different eDirectory user. Click the arrow by the eDirectory username to view a drop-down list containing all the eDirectory users that have the same username (including contexts) as this Windows user. Select one of the eDirectory names and continue with the next listed Windows user.

- Do not merge the Windows user with any of the matching eDirectory users. Click the arrow by the eDirectory username to view a drop-down list, then select Don’t Merge. Select this option only if you know that none of the listed eDirectory users represents the same person as the adjacent Windows user.

After you have made a decision for each listed Windows user, click Finish.

The Project Window will now appear and the Windows users that you chose to merge with eDirectory User objects appear automatically as dropped objects in the destination eDirectory tree.
Model Your Consolidation Project

Most of your work will be done in the Project Window, where you can drag-and-drop Windows User and Group objects into eDirectory containers, and Windows server folders into any volume or folder in the destination eDirectory tree.

The Project Window is a place to model different migration scenarios before you begin the actual migration without affecting your Windows domain or your destination eDirectory tree. All of the planning in the Project Window is done offline, meaning that items moved and created in the Project Window are not actually moved or created until you begin the migration.

**TIP:** For information on shared Windows folders that end with a dollar sign ($), click anywhere on your Windows desktop, press F1, click the Index tab, then type `$shares` in the keyword text field.

The Project Window and the Using the Project Window dialog box appear after you have created the consolidation project. The three basic steps outlined in this dialog box should be performed for each consolidation project. When you are familiar with the tasks that you will be performing, click Close to access the Project Window and begin modeling your migration project.

Using the Project Window

Review the following tips to help you organize your migration project and use the Project Window more effectively.

- **Dragging-and-Dropping the Domain Info object**—To perform a consolidation from a Windows domain, you must drag-and-drop the Domain Info object from the left pane of the Project Window to an eDirectory container in the right pane of the Project Window.

- **Creating a New eDirectory Organizational Unit or Folder**—To create a new eDirectory Organizational Unit (OU), right-click the parent eDirectory Organizational Unit or folder and then click New Organizational Unit or New Folder.

- **Viewing a Description of the Objects in the Project Window**—To see a short description of what an icon represents in the Project Window, right-click an eDirectory object and then click What’s This?

- **Backing Out a Dropped Object**—To return a dropped object to its original position, right-click a dropped Windows object in the domain or the destination eDirectory tree and then click Back Out Dropped Object.

- **Finding Out Where a Dropped NT Object Came From**—To find out where a dropped object was located in the Windows domain, right-click a Windows object and then click Where Did It Come From? When dragging-and-dropping objects, this will help you remember where a dropped object was previously located in the domain.

When you are satisfied with where you have dropped your Windows server folders, users, and groups in the eDirectory tree, verify your consolidation project to resolve any potential problems before migrating your Windows data.

Verify Your Consolidation Project

After you have modeled your consolidation in the Project Window, you should verify that the proposed locations for these new objects do not conflict with existing names, rights, name spaces, etc., in the eDirectory tree.

Remember, dragged-and-dropped items appearing in the eDirectory tree are merely *assigned* to be copied to that area in the eDirectory tree. Objects will not actually be copied until you begin the consolidation process.
Because a similar verification process is run when you begin the actual consolidation, running the standalone verification process prior to consolidation is not mandatory; however, catching any critical errors or warnings now will speed up the verification process during the consolidation.

You must resolve all critical errors before you begin to actually run your consolidation project. Warnings can be resolved after the consolidation.

Run the Consolidation

Although you have selected the volumes and containers where the Windows data will be copied, no data has yet been migrated. When migrated, Windows User objects are converted to eDirectory objects and placed in the destination eDirectory tree.

1. From the Server Consolidation Utility toolbar, click Project > Verify and Copy Data or click the Do the Consolidation button on the toolbar, and then click Next.

2. Read the Welcome screen, then click Next.

3. If you want to apply a Template object to newly created eDirectory users, browse the tree, select the Template object from the tree view, and then click Next.

   If you do not want to use a Template object, uncheck the check box and click Next.

   To migrate home directories, you must use a Template object when migrating your NT users to the destination eDirectory tree. Make sure a Home Directory property is defined for the Template object you are using.

   TIP: If you have not created a Template object but you want to use one now, save the project, go to ConsoleOne®, and create the Template object. Next, run the Server Consolidation Utility again and click Open Last Project. Then restart this migration procedure again starting with Step 1.

4. Decide how you want to handle any duplicate filenames between the Windows NT domain and the destination eDirectory tree, select one of the following, then click Next:

   + **Don’t Copy Over Existing Files**—The file on the source server is not copied and the file on the destination server is not replaced.

   + **Copy the Source File If It Is Newer**—If the file on the source server is newer than the one on the destination server, the file on the destination server is replaced.

   + **Always Copy the Source File**—The file on the source server always replaces the file with the same name on the destination server.

5. Decide how you want to handle passwords for your Windows users, select one of the following, then click Next:

   + **Assign the Same Password to All Users**—The utility will assign the same password to all migrated users.

   + **Assign a Randomly Generated Password to All Users**—The utility will randomly generate passwords, assign them, and then store the passwords it assigns in a file that it creates, named `project_name_out.txt`. This file is saved in the same directory where your consolidation project is located.

   + **Read Passwords from a File**—The utility will migrate the current Windows passwords to the destination eDirectory tree by reading them from a text file. You must create the text file containing the Windows passwords before you begin the migration.

   For more information on how to create this file, click the Help button.
6 Set Windows consolidation options by checking or unchecking the check boxes next to the following options and then click Next:

- **Copy File Permissions**—Normally, the utility migrates file and directory permissions. If, for some reason, you want to reassign file and directory permissions, you can choose to not copy the file and directory permissions here and then assign them later with ConsoleOne.

- **Copy Everyone Permissions**—The eDirectory container that you drop the Windows Domain Info object into will be assigned the permissions that were associated with group Everyone. If you are migrating the Everyone permissions, be sure to drop the Domain Info object high enough in the eDirectory tree so that all Windows users will inherit those permissions.

  **TIP:** Every new folder that is created in the Windows domain automatically receives the Everyone permissions by default.

- **Restart Option**—Normally, this information is not erased; however, if you have previously run a consolidation program and deleted the eDirectory objects from the destination tree, and you are planning to start over and migrate the same domain again, check this check box.

  When you migrate users and groups from Windows, the Server Consolidation Utility stores a table of Windows names and associated eDirectory usernames in the registry of the Primary Domain Controller (PDC). The utility then uses this information when migrating the file system so that it can remember where each user and group has been migrated to in the destination eDirectory tree. By storing this information, the utility can assign the correct file permissions to the appropriate users.

7 To begin the verification, click Next in the Verify NT to NetWare Project window.

8 (Conditional) If prompted, resolve any naming conflicts between different-type objects, then click Next.

   You can choose to merge different-type objects or to keep them as they are.

9 (Conditional) If prompted, resolve any naming conflicts between same-type objects, then click Next.

   You can choose to merge same-type objects or to keep them as they are.

10 (Conditional) If prompted, verify that you do not want to migrate the listed Windows users and groups, then click Next.

   If you migrated all of your users and groups, you will not see this dialog box.

   Otherwise, this step must be done three times—once each for your Windows local groups, global groups, and users that were not dragged and dropped into the destination eDirectory tree.

   If you have made a mistake, click Cancel to return to the Project Window. Then drag-and-drop the objects, go to the toolbar, click Project > Verify and Copy Data, then restart this procedure with Step 1 on page 46.

11 Resolve any critical errors.

   Warnings or noncritical errors can be resolved after the consolidation. To resolve a critical error or warning, read the description in the text field located beneath it. This description should give you a good idea of what could be the possible cause and a suggestion for fixing it.

12 Do one of the following:

   - To start the actual consolidation, click Proceed.
If you are only running the verification process at this point and want to do the consolidation later, click Cancel > Yes to save the changes you have made to the project file.

When you are ready to proceed with the consolidation project, restart the Server Consolidation Utility, select Open an Existing Project, and click OK. Then select the project file you want to open, click Open, and then follow the instructions found in “Run the Consolidation” on page 46, starting with Step 1.

13 (Consolidation only) View the Error and Success Logs.

Continue with the next section, “Perform Post-Consolidation Tasks” on page 48.

Perform Post-Consolidation Tasks

After you’ve migrated your Windows data to the destination eDirectory tree, complete the following tasks:

- Use ConsoleOne or Novell iManager to make sure that your Windows users and groups have been migrated to the correct place in the destination eDirectory tree and have the correct file and share permissions.
  
  **TIP:** If you end up with more or fewer permissions than you planned for, enter `CACLS/?` at the DOS prompt and follow the on-screen instructions. Permissions are sometimes hidden in Microsoft* utilities; therefore, running this command at the DOS prompt lets you see all of the permissions associated with your Windows objects, even the hidden ones.

- At the destination server, use iManager to view the volume that you migrated your data to and verify that it was done correctly.

- Set up your printer mappings in iPrint. For instructions, go to the online documentation (http://www.novell.com/documentation) for the destination server’s operating system and select iPrint.

- Check the migrated users’ home directories to make sure that they were migrated the way you expected them to be.

- Distribute the new eDirectory passwords to all of your users. The passwords are located in a password file that the Server Consolidation Utility created for you named `project_name_out.txt`. This file is located in the same directory where you saved your consolidation project.

Novell ZENworks and Roaming Profiles

If you are using Novell ZENworks® to support Roaming Profiles, ZENworks version 6.5 now creates an NT Roaming Profile directory the first time a migrated Windows user logs into his or her eDirectory account on NetWare. The directory is either the eDirectory User Home Directory or an explicit UNC path, as specified in the ZENworks User Package assigned to that user. The time-consuming process of having the Server Consolidation Utility copy the NT Profile directory is no longer needed and has been removed.
Consolidating Data to OES Linux

The Novell® Server Consolidation Utility supports Novell Open Enterprise Server (OES) on the SUSE® LINUX Enterprise Server 9 (SLES 9) platform as a destination server. This chapter discusses special considerations and steps that must be taken when consolidating data from NetWare® or Windows NT to OES Linux.

Novell recommends that you read through this information carefully and plan how to proceed before you start your OES Linux consolidation project. Complete the following tasks in the order they are listed.

1. Meet System and Software Requirements (page 49).
2. Understand NetWare-to-Linux Data Migration Issues (page 50).
4. Understand the Need for Linux Enabling Users (page 52).
5. Additional Linux Screens in the Server Consolidation Utility (page 52).
6. Run the nambulkadd Command (page 54).

Meet System and Software Requirements

The Server Consolidation Utility runs on a Windows 2000/2003 server or on a Windows 2000 (SP3 or later) or Windows XP Professional Edition workstation on the network. Make sure your machine meets the hardware and software requirements for running the utility (see “Workstation Requirements” on page 15 for details).

Linux destination servers must be installed and running Open Enterprise Server with the following components enabled:

- Novell eDirectory™
- Novell NCP™ Server for Linux
- Novell Storage Services™ (NSS), if copying data from NetWare source servers
- Novell Storage Management Services™ (SMS)
- Novell Linux User Management (LUM)

For more information on installing and configuring OES on Linux, see the OES for Linux Installation Guide.

If you are copying data from NetWare source servers, one or more NSS volumes must be created and configured on the Linux destination server. These are the only volumes where you can drop folders in the Server Consolidation Utility project window. If you are copying data from NT source servers, you can drop folders onto NCP volumes.
For more information on creating NSS volumes, see the *Novell Storage Services File System Administration Guide for OES*.

For more information on NCP volumes, see the *NCP Server for Linux Administration Guide*.

**Understand NetWare-to-Linux Data Migration Issues**

Before using the Server Consolidation Utility to copy data from NetWare servers to OES Linux servers, you should be aware of the issues described in this section.

**Use of SMS to Copy Data**

The Server Consolidation Utility uses Storage Management Services (SMS) tools to copy data from NetWare servers to OES Linux servers. Using SMS preserves as many of the NetWare trustee rights and file/directory attributes as possible.

The Novell Server Consolidation Utility uses SMS as its file copy engine for NetWare consolidations.

**File/Directory Rights and Attributes Supported on Linux**

NCP Server for Linux provides the same trustee rights for both NSS and traditional Linux file systems. These are the same rights that exist for the NSS file system on NetWare:

- Read
- Write
- Create
- Erase
- Modify
- File Scan
- Access Control
- Supervisor

NCP Server for Linux supports the following NetWare file and directory attributes on both NSS and traditional Linux file systems on Linux:

- Read Only
- Hidden

Other NSS file and directory attributes are supported on NSS volumes on Linux. You can use the `attrib` command to view and modify these attributes. However, they are not viewable through any NCP clients.

The NCP Extended Attributes (supported in early versions of NCP) are not supported on Linux.

If the Server Consolidation Utility encounters files with Macintosh* resource forks (supported in early versions of NCP), the resource forks are not copied to the Linux server. However, if you use Macintosh-based backup/restore tools that use AppleTalk* Filing Protocol (AFP) when migrating Macintosh files to a Linux server, you won’t lose any of the Macintosh-specific metadata.
New attrib Command for OES Linux

If you copy files from a NetWare source server that have the Delete Inhibit attribute set, the files cannot be deleted from the destination NSS volume on an OES Linux server using the standard Linux or Windows utilities.

Novell has provided a new attrib command for OES Linux that lets you remove the Delete Inhibit attribute, as well as set or modify other supported NetWare attributes on Linux. For more information, enter `attrib -h` to view the online help.

Creation Dates Change from NetWare to Linux

After copying files from a NetWare source server to an OES Linux destination server, the creation dates for those files change to today’s date rather than the date the files were originally created. Linux doesn’t provide a Creation Date field for file systems, so NCP Server displays the current date.

NFS Name Space Required when Copying Data from TFS on NetWare to NSS on Linux

If you need to transfer data from a traditional NetWare file system (non-NSS) volume on NetWare to an NSS volume on OES Linux, you must first install NFS name space support on the traditional NetWare volume.

Without the NFS name space loaded, the Server Consolidation Utility file copy fails with an error message indicating there is not enough disk space.

Disable Server Consolidation Utility File and Folder Comparison

Novell recommends that you do not enable the Compare Files and Folders verification when copying data from NetWare to Linux. If you do enable this check, you should expect to see many errors reported in the log file, because of the inherent differences in how Linux stores file system data.

Enable UTF-8 Encoding on NCP Client for SCU

When using the Server Consolidation Utility to copy data from servers storing double-byte character set data (Japanese, Korean, and other non-ASCII characters) or extended ASCII character data (multinational characters), you must enable UTF-8 support in the Novell Client™ for Windows 4.91. (UTF-8 support is turned off by default.) This prevents trustees and ownerships from being lost.

Understand Windows-to-Linux Migration Issues

You can use the Server Consolidation Utility to copy data from Windows NT servers to either NSS or Linux traditional file system volumes on an OES Linux server. The Windows users and groups are transferred into eDirectory and their permissions are converted to NSS or Linux equivalents.

If NCP Server for Linux is installed on the server, NCP clients such as the Novell Client for Windows and the soon-to-be-released Novell Client for Linux can access the data on the Linux volumes.
Understand the Need for Linux Enabling Users

When you use the Server Consolidation Utility to copy data from NetWare servers to NSS volumes on an OES Linux server, it transfers the NetWare trustee rights and supported file and directory attributes along with the files. However, in order to preserve file ownerships, the users must be Linux enabled (also known as LUM enabled because the process involves the Linux User Management service in OES).

To become Linux or LUM enabled, an eDirectory User object must be associated with an eDirectory Group object, which is in turn associated with an eDirectory Linux Workstation object that represents the physical Linux workstation/server. The Group object is necessary because NSS on Linux uses Virtual File Services (VFS), which requires both a User ID and a Group ID to authorize access.

For a more thorough discussion of the issues involved with Linux enabling users for OES Linux, see the Novell Linux User Management 2.2 Technology Guide.

Maintaining File Ownership Information

To maintain file ownership information when copying data from NetWare volumes to NSS volumes on OES Linux, Novell recommends that you Linux enable your users before copying their data.

IMPORTANT: If you Linux enable users after their data has been copied to an OES Linux server, the file ownerships might not be re-established immediately on the destination NSS volume. If you use the nambulkadd command to Linux enable your users, the user IDs are updated immediately upon completion of the command. However, if you Linux enable users individually with iManager, ConsoleOne, or the namuseradd command, it could take up to four hours before the user IDs are updated. You can have the update ID process occur immediately by running the refreshids command after Linux enabling the user. For more information, see the Novell Linux User Management 2.2 Technology Guide.

You can Linux enable users either one user at a time using ConsoleOne® or iManager, or in bulk using the nambulkadd command.

For instructions on Linux enabling individual users in iManager, see the Novell iManager 2.5 Administration Guide.

For instructions on Linux enabling individual users with LUM commands, see the Novell Linux User Management 2.2 Technology Guide.

For instructions on Linux enabling users in bulk with the user and group list created by the Server Consolidation Utility, see “Perform Post-Consolidation Tasks” on page 48.

Additional Linux Screens in the Server Consolidation Utility

When you drop a volume or folder onto an OES Linux server in the destination pane of the Server Consolidation Utility, additional screens appear during the Verification Wizard portion of the utility. These screens prompt you for information that facilitates the Linux enabling of your eDirectory users if you have not already done so.

1. Launch the Server Consolidation Utility and proceed through the modeling and verification of your consolidation project as instructed in previous chapters.

   Be sure to resolve any critical errors that are identified during the pre-copy verification.

2. Click Project > Verify and Copy Data on the Server Consolidation Utility toolbar, or click the Do the Consolidation button on the toolbar, and then click Next.
Proceed through the Verification Wizard as instructed in previous chapters of this guide. Toward the end of the Verification Wizard, the Migration Linux-enablement Group Location screen is displayed.

3 Do one of the following:

- If you have already Linux enabled the necessary eDirectory users, click the Skip Linux Enablement box and then click Next. Skip the rest of these steps and proceed with the data copy.

- Click Browse to select an eDirectory container where you want the Linux Enablement Groups to be created or where they already exist. Continue with Step 4.

4 Click Next.

The Linux Enable Users by Container screen is displayed.

You can select containers for the Server Consolidation Utility to scan for User objects. All users in the containers you select, and in all subordinate containers, are added to the list of users to be Linux enabled.

Click Add to browse to and select a container. Or select a container and click Delete to remove it from the list.

5 Click Next.

The Linux Enable Specific Users screen is displayed.

You can select individual users to be Linux enabled that are not included in any of the containers you selected in the previous screen. The User objects you select here are added to the list of users to be Linux enabled, in addition to users in the selected containers.

Click Add to browse to and select a user. Or select a user and click Delete to remove it from the list.

6 Click Next to proceed with the consolidation project.

When the file copy process begins, the Server Consolidation Utility searches the selected containers in the source eDirectory tree for users to add to the Linux enablement list. Any User objects found are added to a file named `project_name-userlist.txt`. All individually selected users are also added to this file.

If your consolidation project is copying data between eDirectory trees, all of the User objects that you match up from the source tree to the destination tree are added to the userlist file as well.

The SCU also creates a file named `project_name-grouplist.txt` for each destination OES Linux server.

At the conclusion of the file copy process, the eDirectory User Linux Enablement Directions screen appears, displaying information you need to run the nambulkadd command on your destination Linux servers.

- Userlist file path: This is the full path and filename of the userlist file created by the Server Consolidation Utility.

- Grouplist file path: This is the full path and filename of the grouplist file created by the utility.
Linux server list: This is a list of servers where you need to run the nambulkadd command to Linux enable users.

Record this information for later reference. The filenames and paths are also written to the project’s success log file.

Run the nambulkadd Command

The nambulkadd command is designed to be used with the userlist and grouplist text files created by the Server Consolidation Utility. The command Linux enables multiple users and groups all at the same time.

After your consolidation project has run to completion, follow these steps to run the command and Linux enable your users.

1. At the OES Linux server, log in as root.
2. At the shell prompt, enter the following:
   
   ```bash
   nambulkadd [-a adminFDN] [-w admin_password] [-u /path/userlistfile] [-g /path/grouplistfile]
   ```

   Replace `adminFDN` with the fully distinguished name of the eDirectory administrator, using LDAP syntax (CN=admin,OU=novell).

   Replace `admin_password` with the password for the eDirectory Admin user.

   Replace `/path/userlistfile` with the full path and name of the userlist.txt file located in the `/usr/novell/sys/scu/lum` directory on the Linux server. If there are spaces or dashes in the filename, enclose the filename in quotation marks, as in `-u /usr/novell/sys/scu/lum/"NT -Linux-userlist.txt"`.

   Replace `/path/grouplistfile` with the full path and name of the grouplist.txt file located in the `/usr/novell/sys/scu/lum` directory on the Linux server. If there are spaces or dashes in the filename, enclose the filename in quotation marks, as in `-g /usr/novell/sys/scu/lum/"NT -Linux-grouplist.txt"`.

   If you prefer to not include the eDirectory Admin password in the command, you can set it as an environment variable and omit the `-w` parameter. To do this, enter the following at the shell prompt:

   ```bash
   export LUM_PWD=AdminPassword
   ```

   where `AdminPassword` is the password of the eDirectory Admin user.

   **IMPORTANT:** Be sure to double-check the accuracy of the paths, filenames, and other parameters you specify for this command. If you type a parameter incorrectly, the command simply returns without displaying any errors.

3. Check the log file `/var/log/messages` for errors.

Run nambulkadd on one server at a time, and wait until the command completes on one server before running it on the next one.

**TIP:** After you have Linux enabled users for one server, you can easily Linux enable them for another server by adding the Linux Enablement Group to the other server’s Workstation object in eDirectory using iManager. See the Novell iManager 2.5 Administration Guide for details.
Example

nambulkadd -a cn=admin,o=novell -w novell -u /usr/novell/sys/scu/lum/job1-userlist.txt -g /usr/novell/sys/scu/lum/job1-grouplist.txt

This command Linux enables the Group object listed in job1-grouplist.txt and all the User objects listed in job1-userlist.txt. The users are all made members of the group named server_name-LUMGroup that is created.

To see additional help and usage examples, enter

nambulkadd -h

To check whether a user is Linux (LUM) enabled, enter this command at the shell prompt:

id user_name

If the user has been Linux enabled, the screen displays information such as:

uid=624(User103) gid=607(gd2600-LUMGroup) groups=607(gd2600-LUMGroup)

For more information about the nambulkadd command, see the Novell Linux User Management 2.2 Technology Guide.
Troubleshooting

Refer to the appropriate section if you are having trouble.

Troubleshooting the Server Consolidation Utility

- “General Troubleshooting” on page 57
- “Contents of the NDS Container Can’t Be Listed Error” on page 57
- “SMDR Not Communicating” on page 57
- “NDPS Printer Agents Don’t Migrate” on page 58
- “NUWAGENT Won’t Load (NetWare 4.2 Only)” on page 58
- “Server Consolidation Performance Problems” on page 58
- “Volume Contents Do Not Display” on page 59
- “Copies Incomplete Data Files” on page 59
- “Errors When Connecting to a NetWare 4 Server” on page 59

General Troubleshooting

Explanation: In general, when troubleshooting errors in the Server Consolidation Utility, first ensure that the latest smdr.nlm and tsafs.nlm modules are loaded on the source and destination NetWare servers.

Contents of the NDS Container Can’t Be Listed Error

Possible Cause: Your workstation is not running Novell Client™ for Windows* 2000/XP* version 4.91 or later.

Action: Download version 4.91 of the Novell Client software from the Novell Downloads page (http://www.novell.com/download) and install it on your workstation. See “Workstation Requirements” on page 15 for other workstation requirements.

SMDR Not Communicating

Possible Cause: Smdr.nlm is not loaded on either the source or the destination server, or SLP is not properly configured.

Action: Enter `display slp services smdr.novell// (svcname-ws==source_server_name)` (replace `source_server_name` with the name of your source server) at the destination server console.

If smdr.nlm is not loaded on the source or destination server, manually load it.

If it appears there is a problem with SLP, go to Novell’s Knowledgebase (http://support.novell.com/search/kb_index.jsp) and search for SLP-related configuration information.
**NDPS Printer Agents Don’t Migrate**

Possible Cause: If after a migration, it appears NDPS® Printer Agents have not migrated, it is possible that NDS® has not had time to properly synchronize.

Action: Wait for a few minutes, then check again to see if NDS has been updated to reflect the Printer Agent migration.

Action: If the Printer Agents have still not migrated after allowing NDS to synchronize, ensure the Novell® Distributed Print Services™ Manager (ndpsm.nlm) is loaded on either the source or destination server.

**NUWAGENT Won’t Load (NetWare 4.2 Only)**

Possible Cause: Clibaux.nlm is not loaded.

Action: Go to the server specified in the error message and at the server console, enter `load clibaux.nlm`.

**Server Consolidation Performance Problems**

Explanation: The performance of a project can be determined by looking at the success log after a project completes. The success log gives the amount of time the project took to complete and the amount of data copied.

There are several factors that determine the performance of the file copy. It is also important that each server is updated to the latest Support Pack to ensure you have the latest performance enhancements for SMS™.

Possible Cause: Heavy traffic on the network.

Action: Speeds can be increased by connecting servers and the workstation to a dedicated switch.

Possible Cause: A mismatch in duplexing among servers, switches, and the workstation.

Action: Make sure all hardware is set to either full duplex or half duplex. Setting all hardware to half duplex might result in greater performance than full duplexing.

Possible Cause: Virus scan software running on the source or destination servers.

Action: Turn off any virus scanning software on the source or destination servers to increase the speed of the consolidation. Turn the virus scanning software back on after the consolidation completes.

Possible Cause: An incorrect version of smdr.nlm is loaded on a NetWare® 5 server.

Action: At the NetWare 5 server, unload smdr.nlm, then load the smdr.nlm file that comes with the Server Consolidation Utility.

Possible Cause: Small file sizes.

In general, the larger the file sizes, the better the performance. Copying a single 500 MB file will be significantly faster than copying five thousand 100 KB files.

Possible Cause: Hardware configuration.

The performance of the Server Consolidation Utility varies according to the environment. Using a 100 MB LAN, tests have measured speeds ranging from 3 to 15 GB per hour, with the most common speed being between 5 and 8 GB per hour. You should check the performance of your LAN before copying very large amounts of data.

The Server Consolidation Utility will copy data at a faster rate than a Windows® file copy.
Volume Contents Do Not Display
Problem: No data appears in the Volume object after dropping a container into a volume that has not been opened.
Action: Map a drive to the volume from a workstation.

Copies Incomplete Data Files
Problem: Files copied to the destination server have any of the following characteristics:
- Destination is a 0-byte file.
- Creation time and date are incorrect when compared to the source server.
- Modification time and date are incorrect when compared to the source server.
- File was not completely copied. (This would be indicated by the destination file being smaller in size than the source file.)
Action: Use the latest TSA500 and SMDR on the source server if it is a NetWare 5 server.
Use the latest TSA600 and SMDR on the source server if it is a NetWare 6 server.
For more information, see TID #10076801 in the Knowledgebase at Novell’s Support Web site (http://support.novell.com).

Error When Migrating a Cluster Volume
Problem: When using the Server Consolidation Utility and migrating data from or to a cluster volume, an error (0xFFFDAE) might occur if your cluster server nodes are spread throughout different eDirectory contexts. If the server (from the SCU project) that holds the mounted cluster volumes does not have rights to the cluster Virtual Server object and the cluster-enabled Volume object, and does not have a Read/Write replica of the partition these objects reside in, then a failure fffdae is displayed on the Verification screen of the Server Consolidation Utility.
Action: To resolve this, add the server as a trustee of the context that contains the Virtual Server and Cluster Volume objects. The default rights assigned when adding the trustee are sufficient.

Errors When Connecting to a NetWare 4 Server
Problem: When attempting to connect to a NetWare 4 server, any of the following types of errors are returned:
- An error occurred opening the file. filename was invalid.
- Error opening connection to SMDR.
- The name spaces couldn’t be checked.
- 8998 error. NWGetVolumeNumber.
Action: There are several actions to take if errors are returned when trying to connect to a NetWare 4 server, including the following:
- If your source server is NetWare 4, make sure that you have IPX™ on your client. For information on verifying IPX on your client, see “Verifying IPX Is Bound on the Client” on page 39.
- Add a mapped drive to the source server.
- Ensure that SLP is configured properly on the servers involved in the consolidation project.
Problem: NetWare 6.5 won’t communicate with NetWare 4 during a consolidation. IPX was not installed during the NetWare 6.5 installation.

Action: Add IPX to the NetWare 6.5 server after the NetWare 6.5 installation is complete.

1. Enter `edit` at the NetWare 6.5 server console.
2. Press the Insert key.
4. Select System and press Enter.
5. Select `autoexec.ncf` and press Enter > Enter.
6. Add the server ID of the source server and save the `autoexec.ncf` file.

Problem: IPX connection is not communicating.

Action: Ensure that there is an IPX connection to the server.

To verify that the source and destination servers can see each other via IPX:

1. On the server console of the destination server, enter `serverid xxxxx`, where `xxxxx` is the unique server ID number for the server.
2. Enter `load ipxping`.
3. Enter the internal IPX number of the source server.
4. Repeat this process on the source server, replacing the internal IPX number of the source server with the destination server’s internal IPX number in Step 3.

Action: Bind IPX on the destination server.

1. At the destination server console, enter `inetcfg`.
2. Select Boards and press Enter.
3. Press the Insert key.
4. Select the appropriate network interface and press Enter.
5. Enter a board name and slot number, then press the Esc key.
6. Select Yes to save changes and press Enter.
7. Press the Esc key to return to the main Internetworking Configuration screen.
10. Enable and configure IPX and exit the `inetcfg` utility.

TIP: If you prefer, IPX can also be enabled on the server by adding the appropriate Load and Bind commands to the server’s `autoexec.ncf` file.

Action: Verify that IPX is bound on the client running the Server Consolidation Utility:

1. Right-click on the red N in the system tray on your workstation.
2. Select Novell Client Properties.
3. Select the Protocol Preferences tab.

   If the Protocol window displays both IP and IPX, the client has IPX bound.

   If the Protocol window displays only IP, then IPX needs to be bound on the workstation.
Action: Bind IPX on the client running the Server Consolidation Utility:

1. Insert the *Novell Clients Software CD (March 2003)*.
2. Select the client version you want and click Next.
3. Select the appropriate language and click Next.
4. Select Custom and click Next.
5. Click the radio button next to one of the following two choices:
   - IP and IPX
   - IP with IPX compatibility
   **TIP:** You can select this choice if you are running in an scmd environment.
6. Click Next > Next > Finish.

Action: Ensure that the correct smdr.nlm and tsa.nlm are loaded on the server.

1. On the server console, enter `unload smdr`.
2. Enter `smdr new`.
3. Enter `N` when asked if you want to disable NDS.
4. Enter `N` when asked if you want to disable SLP.
5. Enter `N` when asked if you want to disable SAP.
6. Enter `N` when asked if you want to disable name resolution through `sys\etc\hosts` file.
7. Enter `load smdr` on the server console.
8. Enter `load tsa600` on the server console.
Changing the NetWare Server Code Page

When using the Server Consolidation Utility, the source and destination NetWare® servers must have the same code page set, or data will be lost during the consolidation.

**WARNING:** Novell does not recommend converting a foreign-language code page server back to English, nor converting a foreign-language code page server to another foreign-language code page. If either is done, it is possible that documents and folders named with or containing foreign characters might become irreversibly corrupted.

There are two recommended ways to create a NetWare server with foreign-code page support:

- Install the server with the regional support you want
- Convert an English server to a foreign-language code page

**Install a NetWare Server with Regional Support**

To install an English server with code page support for a foreign language, you must have an English NetWare® installation CD or access to English NetWare install files.

1. Begin the NetWare installation.

   For information on installing your specific version of NetWare, see the NetWare on-line documentation (http://www.novell.com/documentation).

   During the installation, a Regional Settings screen will display. You will see three options:
   - Country: 001 (USA)
   - Code page: 437 (United States English)
   - Keyboard: United States

2. Change the first option, Country:, to the country you want the server to support.

   For example, if you want to install your English server with Japanese double-byte support, change the Country: option to 081 (Japan).

   When you change the Country: option, the Code page: and Keyboard: options change automatically to the appropriate code page and keyboard.

3. If you intend to type foreign characters using the keyboard on the server console, accept the automatic setting displayed for the Keyboard: option.

   If you do not intend to type any foreign characters on the server console, manually change the Keyboard: option to US International (the last keyboard option displayed in the list).

4. Complete the server installation.

   When the server reboots after the installation is complete, you will have an English server with a foreign code page.
Convert an Existing NetWare Server to a Foreign Code Page

To convert an existing English server to a foreign code page, you must have an English NetWare installation CD or access to English NetWare install files.

1. Bring the server down.
2. At the DOS prompt, go to c:\nwserver.
3. Rename lconfig.sys to lconfig.437.

The lconfig.sys file determines what code page NetWare will run. The purpose of renaming the existing file is to allow for rolling back to the original configuration if necessary.

4. Browse to the \install\lconfig directory on the NetWare installation CD or at the location of your NetWare installation files.

This directory contains the lconfig.sys files for all languages. The naming convention is lc_country_codepage.country_telephone_code. Therefore, the Japanese lconfig.sys file is named lc_932.081, for example.

The following is a partial list of lconfig.sys files with their associated language names:
- Chinese-S LC_936.086
- Chinese-T LC_950.088
- French LC_850.033
- German LC_850.049
- Italian LC_850.039
- Japanese LC_932.081
- Korean LC_949.082
- Portuguese LC_860.351
- Russian LC_855.007 or LC_866.007
- Spanish (Argentina) LC_850.054
- US English LC_437.001

5. Select the language code page file you want to implement and copy it to the c:\nwserver directory.

6. Rename the lc_XXX.XXX file you just copied to lconfig.sys.

If you are converting an English server to a single-byte language like German or Russian, then you are finished. When you start the server, you will have foreign-language code page support for the country you selected.

If you have selected a double-byte code page like Japanese or Chinese, continue with Step 7.

7 (Conditional) If installing a double-byte codepage, copy the necessary server font files.

7a. Go to :\startup on your NetWare installation CD and select the font files appropriate for your language:
- Japan = jpn*.fnt
- Korea = kor*.fnt
- Chinese T = bg5*.fnt
Changing the NetWare Server Code Page

7b Add Load vgadisp.nlm to c:\nwservers\startup.ncf.

Vgadisp.nlm allows for double-byte characters such as Japanese or Chinese to be viewed in the C-worthy portion of the system console. It is cosmetic and does not affect the functionality of the server.

8 Restart the server.

You will now have foreign-language code page support for the country you selected.

Verifying the Current Code Page on a NetWare Server

To verify the code page currently installed on your NetWare server, enter language at the server console.

This will return “Current NLM language is (4) ENGLISH. Current DOS code page is (437)”, if your server is using the English code page.

The following is a partial list of common codepages:

• Chinese-S 936
• Chinese-T 950
• French 850
• German 850
• Italian 850
• Japanese 932
• Korean 949
• Portuguese 860
• Russian 855 or 866
• Spanish 850
• US English 437